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Info-ZIP License

This is version 2007-Mar-4 of the Info-ZIP license.

The definitive version of this document should be available at ftp://ftp.info-
zip.org/pub/infozip/license.html indefinitely and a copy at www.info-zip.org/pub/infozip/license.html.

Copyright (c) 1990-2007 Info-ZIP. All rights reserved.

For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter
Goatley, Ed Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath,
Jonathan Hudson, Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor
Mandrichenko, Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe
Rommel, Steve Salisbury, Dave Smith, StevenM. Schweda, Christian Spieler, Cosmin Truta, Antoine
Verheijen, Paul von Behren, RichWales, MikeWhite.

This software is provided "as is" without warranty of any kind, express or implied. In no event shall
Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential
damages arising out of the use of or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial
applications, and to alter it and redistribute it freely, subject to the above disclaimer and the following
restrictions:

1. Redistributions of source code (in whole or in part) must retain the above copyright notice,
definition, disclaimer, and this list of conditions.

2. Redistributions in binary form (compiled executables and libraries) must reproduce the above
copyright notice, definition, disclaimer, and this list of conditions in documentation and/or other
materials provided with the distribution. The sole exception to this condition is redistribution of a
standard UnZipSFX binary (including SFXWiz) as part of a self-extracting archive; that is permitted
without inclusion of this license as long as the normal SFX banner has not been removed from the
binary or disabled.

3. Altered versions, including, but not limited to, ports to new operating systems, existing ports with
new graphical interfaces, versions withmodified or added functionality, and dynamic, shared, or
static library versions not from Info-ZIP, must be plainly marked as such andmust not be
misrepresented as being the original source or, if binaries, compiled from the original source. Such
altered versions also must not bemisrepresented as being Info-ZIP releases--including, but not
limited to, labelling of the altered versions with the names "Info-ZIP" (or any variation thereof,
including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without
the explicit permission of Info-ZIP. Such altered versions are further prohibited from
misrepresentative use of the Zip-Bugs or Info-ZIP email addresses or the Info-ZIP URL(s), such as to
imply Info-ZIP will provide support for the altered versions.

4. Info-ZIP retains the right to use the names "Info-ZIP", "Zip", "UnZip", "UnZipSFX", "WiZ", "Pocket
UnZip", "Pocket Zip" and "MacZip" for its own source and binary releases.
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Chapter 1: Introduction

What is Harmony?

Harmony is a revolutionary team-based infrastructure for animation production. Its array of cutting-
edge features increases productivity and encourages creativity. Developed in conjunction with leading
studios worldwide, Harmony is specifically designed for long-term episodic and feature length
projects, providing a true animation pipeline. Several animators can work simultaneously on the same
scene while the asset library provides users with easy access to up-to-datemedia assets.

Harmony is truly scalable; more than 100 staging clients can share animation just as easily as a few can.
Whether you are a start-up studio or a large established animation facility, Harmony serves as the
animation backbone ensuring sustainability and growth.

Harmony is a powerful solution that brings together multiple teams working on the same project,
whether in-house or remotely. The Harmony solution offers a robust asset management system that
enables users to quickly locate assets, share tasks on complex scenes and centralize all assets in a
common repository. Tremendous gains in efficiency and quality aremade by the teams, who enjoy a
smooth flow between each task, and more time dedicated to their creative assignments.

What is Toon Boom Harmony Server?
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At the heart of the Harmony solution is the server, which centralizes all the production assets in a
repository. Loaded with production proven tools to manage administration tasks, the server is
completely flexible and will fit in your existing infrastructure, whether you are onWindows, Linux or
Mac.

In addition, the server is critical at the end of a production for rendering projects efficiently. The
Render module, controlled directly by the server, not only renders production scenes but also
executes the batch vectorization of the scanned drawings. You can connect an unlimited number of
Render nodes and change priority depending on the deadline! You can also render final frames locally
or batch process over a network in the background or at scheduled times.

What is Toon Boom Cloud?

When you're running a studio, you will most likely have a database setup. This enables all the artists
working on your production to share the same scenes and assets.

What the Toon BoomCloud enables you to do is to host this database on the Internet. Then, you can
have freelancers log in from anywhere with an Internet connection. They can download a scene from
the database, work on it, and upload it again. No more need to spend time copying files to an FTP.
No need to have an admininstrator exporting and importing files from the database. You can do it all
directly through the Cloud.

What's in this Guide?

The Toon BoomHarmony Control Center and Server Guide was created to help you set up and
manage your Toon BoomHarmony Server and rendering queue.

This book is divided as follows:

• Control Center Module on page 11

• Harmony CloudModule on page 61

• Batch Processing on page 109

10
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Chapter 2: Control Center Module

Using the Harmony solution and the Toon BoomHarmony Server has the advantage that it centralizes
your entire production on your server and organizes it into structured database. The key piece of
Toon BoomHarmony Server is the Control Center module. From the Control Center, you canmanage
your production database, users, visualize your rendering queue andmore.

This chapter explains the general administrative tasks whichmust be performed to successfully run the
Harmony solution.

This chapter is divided as follows:

• Starting the Control Center on the next page

• Centralized Data and Global Locking on page 17

• Managing Harmony Users on page 18

• Managing Environments, Jobs and Scenes on page 25

• Exporting and Importing Data on page 45

• Control Center Commands on page 53

11



Chapter 2: Control Center Module Starting the Control Center

Starting the Control Center

To manage a production, you will need the Control Center module. Control Center is used to create
new environments, jobs, scenes and users, as well as to import and export scene packages. Control
Center directly manages your server database.

You can start the Control Center from the server or any client machine.

12
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Before accessing themain Control Center interface, the Database Login dialog box opens, requesting
a user name. By default, there is a user name created called usabatch. Type this user name to log in
the first time. Once logged into Harmony, you can create your own set of users.

Do not delete the usabatch user name as it is used by Toon Boom Harmony Server for batch
processing.

How to open the Control Center

1. Do one of the following:

‣ Windows: Select Start > All Programs > Toon Boom Harmony 11.1 > Control Center.

‣ MacOS X: Select Finder > Applications > Toon BoomHarmony 11.1 > Control Center.

‣ Linux: /usr/local/ToonBoomAnimation/harmony_
11.1/ln86/bin/Controlcenter
You can also type Controlcenter in a command shell window.
You can also select Applications >Toon Boom-Harmony_11.1 > Control Center.

The Database Login dialog box opens.

2. In the User Name field, type usabatch. This is the default Harmony user.

The Control Center application opens.
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Control Center User Interface

The Control Center interface is divided into six areas:

Parameter Description

Topmenu
Contains all the commands available in Control Center. You can also find
the commands in the contextual menus available in each area by right-
clicking.

Environments
The Environments area shows one of your projects, such as a feature film,
a TV series or a group of TV spots.

Jobs
The Jobs area shows the sequences or episodes in your project
(Environment). You can only see your jobs once you select a
project from the Environments list.

Scenes
The Scenes area shows the scenes in your episode or sequence
(Job). You can only see your scenes once you select a job from
the Jobs list.

Elements
The Elements area shows the layers or columns in your scene.
You can only see your elements once you select a scene from
the Scenes list.

Drawings
The Drawings area shows the drawings in your layer or column
(Element). You can only see your drawings once you select an

15
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element from the Elements list.

You can collapse and expand the Elements and Drawings sections of the user interface. As the
elements and drawings are not created in Control Center, these sections are used less often. To
simplify the interface, you can click on the Collapse/Expand button to show or hide the Elements
and Drawings sections.

Here is a typical example of the database structure:

16
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Centralized Data and Global Locking

Whenworking with the Harmony solution and Toon BoomHarmony Server, all scenes and their data
are stored directly on the server; no data is saved or stored on the client machine. The client machines
access the database and load the scenes and drawings directly from the server. Each time the user
saves a scene, the data is updated directly on the server. There are no upload or download operations
done between the server and the clients.

Harmony has a lock system, referred to as global lock, for the different scenes and scene assets. As all
the data on the server can be accessed directly and modified from any client machine, by default, the
scenes are locked and the users need to get the rights to modify them in order to save their work onto
the server. Only one user at a time canmodify a scene. Once a scene is opened on a client machine,
other users can only open the scene in read-only mode if they need to consult it, but they will not be
able to save anymodifications.

Global lock has three levels:

• Get rights to modify the scene: Allows the user to modify the selected version of the scene and
have access to the versionmanager during the opened session.

• Get rights to modify the scene version: Allows the user to modify the currently selected scene
version but locks access to the versionmanager during the opened session.

• Get rights to modify the scene assets: Automatically gets all the edit rights for the selected
version of the scene. This option is only recommended if you are certain that the selected scene
cannot be opened for editing by several users at the same time. Large studios should avoid this
option.

There are several different ways to get the rights to modify the scenes. This can be donewhen:

• The user loads a scene.

• An environment is created.

• A job is created.

• A scene is created.

• User's preferences.

17
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Managing Harmony Users

In an animation studio, there are usually several people using Harmony who will probably be assigned
different tasks, such as ink and paint or compositing. Normally, you should create a different user for
each one. This way, the person assigned to ink and paint will only have access to the Paint module and
not to other functions that are not relevant to their work.

Anyone who uses Harmonymust have a login name in order to run any of themodules. The Harmony
login is independent from the computer session login.

By default, only the usabatch and BATCH users are created. However, you should not use them for
your staff. These should be kept for the Toon BoomHarmony Server when performing background
operations, such as batch processing.

The User List dialog box lists all the users and their details, including: user name, first and last names,
and user type. The buttons at the bottom of the dialog box let you add, delete or modify the list of
users.

These are the different modules and applications in which a user can log in:

• Control Center module

• Stagemodule

• Paint module

• Xsheet module

• Scanmodule

• Playmodule

• Draw module

• Sketchmodule

All Harmony users must have their name on the user list to log in to any application. The system uses
the login to track activities; it is not a security lockout.

Each login also has a user "type" assigned to it which allows access to only some of the Harmony
modules.

As your studio network grows and evolves, youmay need to delete old or obsolete user profiles from
your system. After you delete a user profile, the person who used that profile will no longer be able to
access Harmony.

You cannot delete yourself from the user list. If you accidentally delete a name, youmust follow the
procedures for adding a user to get the name back into the system.

You canmodify the user profiles at any time to update the user information.

You can only change other user profiles. If you log in using your personalized login name, you will not
be able to modify your own user profile.

To change your own user profile, login as usabatch (the default user).
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How to view the user list

1. From the top menu, select Admin > Users.

The User List dialog box opens and displays your login name and a list of the other users in the
system.

How to add a user to Harmony

1. To view the list of Harmony users, select Admin > Users.

The User List dialog box opens.

2. Click Add.

The Add User dialog box opens.

3. In the User Name field, type the person's user name.

Make sure the user name does not exceed the 12-character limit.
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4. Type the person's first name and last name in the corresponding First Name and Last Name fields.
You can enter a space if you want leave the field blank.

5. In the Typemenu, select the user type. This defines the type of work the user typically performs. It
will allow or block the person from accessing certain Harmony applications and perform
operations in Control Center.

6. Click OK.

The name appears in alphabetical order in the user list.

How to delete a user

1. To view the list of users, select Admin > Users.

The User List dialog box opens.
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2. In the user list, select the name youwant to delete.

3. Click Delete.

The Confirm dialog box opens.

4. Confirm if you want to delete the user fromHarmony.

‣ Click OK to delete the selected user.

‣ Click Cancel to abort the delete command.

How to modify user information

1. To view the list of users, select Admin > Users.

The User List dialog box displays.

2. Select the profile to modify.
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3. ClickModify.

TheModify User dialog box appears.

4. Type or select the new information in any or all of the following:

‣ User Name: The user's login name

If you modify the user name, make sure that it does not exceed the 12-character limit.

‣ First Name: The user's given name

‣ Last Name: The user's family name

‣ Type: The type of access the user has in the system

5. Click OK.

User Types and Restrictions
Here are the different user types available and their restrictions:

Feature
RND / Coordinator / Super-
visor / TD / Executive

Animator
Xsheet /
Archive

Scan
Ink &
Paint

Create Environment •
Change Asset Lock on Envir-
onment •

Delete Environment •

View VectorizeQueue • • • • •

View Render Queue • • • • •

Create Job • •

Change Job Priority • • • • •

Change Job Stage •
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Delete Job •

Create Scene • • • •

Delete Scene •
Unlock scenes locked by
another user •

Unlock scene version locked
by another user •

Unlock scenes locked byme • • •
Unlock scene version locked
byme • • •

Move Scene •

Rename Scene •

Clear Scene •

Change Scene Priority • • • • •

Change Scene Stage •

Reorder Scenes •

Copy Scenes • •

Send to Vectorize • • • • •

Send to Unvectorize • • • • •

Send to Rendering • • • • •

Add/Modify/Delete Users •

Change Approval Policy •

Change Vectorize Style • • • • •
Change Lock WhenOpening
Scene •

Database Lock Manager •

Export Scenes • • •

Import Scenes • • •
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View Error Log • • • • •

View Elements • • • • •

View Drawings • • • • •

Open in Stage • • •

Open in Paint • • • •

Open in Scan • • • • •

Creating a Default User for Batch Processing
If you intend to use the batch processing feature in Harmony or if you are installing the application on
the server machine, youmust create:

• An operating system user called usabatch

• AHarmony user name called usabatch through theControl Centermodule.

Harmony uses this user profile during batch rendering.

It is important to verify that these users exist before starting a project and setting the batch
processing.

• Operating System Users

Windows: The usabatch operating system user profile was automatically created by the
installation wizard.

MacOS X: The usabatch operating system user profile must be created manually or using the
configuration assistant.

Linux: Youmust manually create the usabatch operating system user.

Regardless of the operating you are using, a usabatch user account must exist on your operating
system. If you need to create this account, see your system administrator.

• Harmony User Names

The usabatch Harmony user is created during the installation process onWindows, MacOS X and
Linux. There is no need to create it manually unless it was deleted. To manually create the usabatch
Harmony user, refer to the Toon BoomHarmony Installation Guide.

24



Toon Boom Harmony 11.1 Control Center and Server Guide

Managing Environments, Jobs and Scenes

Every project you create with the Harmony solution starts with an environment; it is the highest level in
the Control Center module. You can build a complete environment by adding jobs, scenes, elements
and drawings.

The Control Center module divides your animation project into the following categories which
organize the components of your animated projects:

• Environment: This is the name of your animation project.

Example: adventure_movie

• Jobs: These are themajor sections of an environment, such as sequences or episodes.

Example: adv_seq_001, adv_seq_002

All jobs are stored in the same location in the Harmony database. Be sure to prefix all job names
appropriately, so you can identify the project it belongs to. Each job must have a different name. You
cannot give two jobs the same name.

• Scene: These are the different shots in a job.

Scenes are contained in their respective job folder in the Harmony database. Prefix all scenes
names appropriately, so you can identify which environment and job they belong to.

Example: sc_001, sc_002
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• Elements: These are the different layers and columns in your scenes.

If you have not created an exposure sheet yet, the Frames column in the Scenes list displays 0 and
no elements appear in the Elements or Drawings list.

For example, scene 002 of show_episode_6 could have the following elements:

• A background called bg.

• A character called tony.

• A highlight effect called hl.

You would then find these elements under job 002 and the show_episode_6 scene. The
Elements list would display the element names, types of elements in a scene, the type of scans, and
the size of the field chart.

• Drawings: These are actual drawings of the elements (layers) in your scene.

For example, the tony element in 002 of show_episode_6 could consist of 35 drawings. To find
these drawings, you would look under Drawings to see the keyframes, state, and stage of each
drawing.

As your projects come and go, you will probably want to start cleaning up your database, as well as
your server's hard disk, by removing old and obsolete environments and their associated animation
data.

After you delete a scene, job, or environment, the associated data is permanently removed from
your storage disks. Make sure you really want to erase these items before you delete them as there is
no way to retrieve the data after it has been erased.

Youmight want to export old environments and archive them somewhere else before you delete them
from your system.

If you are working in a mixedWindows/Mac OS X/Linux environment or share files with other studios
that do, you should use lowercase letters to name the various items in your animation projects and
not include any spaces in component name. For example, write the_show instead of The Show. This
recommendation is due to the fact that Linux is case-sensitive while Windows is not.

Managing Environments
Harmony uses environments to manage and organize related projects. Using environments allows you
to organize your production projects by their nature or type.

If your projects center around episodic and commercial types of work, you can create two
environments. For example, there can be one called commercials and the other called the_show.
Then you can insert the jobs that relate to each type of project. When youwant to work on a
commercial project, open the commercials environment and select the commercial job you need.
Similarly, if you want to work on an episodic project, open the environment called the_show.
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Environment Job

commercials

dentist
sc_001

sc_002

soda sc_001

cereal sc_001

the_show

sho_001
sc_001

sc_002

sho_002 sc_001

dentist
sc_001

sc_002

When you are ready to remove old environments, you can delete them from the database. However, in
order to prevent accidental loss of data, you can only delete an empty environment (an environment
that contains no jobs, images, or palette information).

How to create an environment

1. Do one of the following:

‣ From the top menu, select Environment > Create.

‣ Right-click in the Environments section and select Create.

In mixed platform Environments (Windows/MacOS X andWindows/Linux) it is best to name
everything in lowercase so data can be interpreted the sameway on each operating system. The
same is true if working between studios usingWindows, MacOS X, and Linux.

The Create Environment dialog box appears.

2. In the Environment Name field, type the new project's name.

The environment name is alphanumeric and can include underscores (_), but no spaces or other
special characters. The environment name is case sensitive.
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3. If you want the user to automatically get the rights to modify all the scene assets (drawing, scene
setup, palette lists, etc.), select theGet Rights toModify All Scene Assets option.

4. Click OK.

The new environment appears in alphabetical order in the Environments list.

After you create an environment, youmust add it to the Batch Processing queue so it can vectorize
and render the drawings and scenes automatically. You only have to add the environment to the
Batch Processing queue once.

How to delete an environment

1. In the environment section, select the environment to delete from the Environments list.

2. Do one of the following:

‣ From the top menu, select Environment > Delete.

‣ Right-click in the Environments section and select Delete.

The Delete command is only available for an empty environment. You must delete the scenes and
jobs before you can successfully delete the environment.

The Confirm dialog box appears.

3. Click Yes to delete the selected Environment.

The environment no longer appears in the Environments list.

Setting the Resolution File

When you create a new environment or job, you can create a project resolution list that will appear in
Harmony Stage. If you work with a particular resolution, you can insert it in your list so it`s available
when doing the compositing in Harmony Stage.

You need to copy the resolution.conf file at the server, environment or job level. If you insert the
file at the environment level, it is not necessary to add one at the job level. All jobs in the environment
will use the resolution.conf file at the environment level. If you want all environments to use the same
resolution.conf file, you can place the copy at the server level in the USA_DB folder.
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Starting with HarmonyNetwork 11.1, the resolution list is stored in an XML file. The resolution.conf
file is still used and it is still the file that you will copy from the samples folder. If youmodify the
resolution list in the Scene Settings dialog box, Harmony will convert the file to an XML file.

The resolution.conf file can be found in:

• Windows: Program Files > Toon Boom Animation > Harmony 11.1 > resources > samples

• MacOS X: Applications > Toon Boom Harmony 11.1 > tba > resources > samples

• Linux: /usr/local/ToonBoomAnimation/harmony_11.1/resources/samples

Insert the Resolution.conf file in the following directory:

Resolutions common to
all jobs in the
environment.

/USA_DB/environments/environment_
name/resolution.conf

Resolutions common to
all scenes in the job.

/USA_DB/db_jobs/job_name/resolution.conf

Resolutions common to
all scenes and
environments.

/USA_DB/resolution/resolution.conf

All scenes found under the environment or job have access to the resolutions stored in that file.

You can simply type new resolutions, modify or delete existing ones from the list. This file can also be
sent to other studios with whom youmay beworking.

Below is the resolution.xml file created by Harmony.
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Managing Jobs
Within each environment is a list of jobs. These jobs contain all the segments for your animated
sequence. If you are creating a weekly television series called The Show, you could name your job
show_ep_06 (the_show would be the name of your environment).

If each episode was composed of 100 animated shots, each job would contain 100 scenes.

Each job must have a unique name. You cannot have two jobs with the same name, even if they appear
in two different environments. On the server, all the jobs are contained in the same folder.

As you continue working on your animation project, youmay want to update the status of the jobs in
your environment. This status can display one of three things:

• The stage the job has reached

• When the job will be vectorized

• When the job will be rendered

As you complete your animation project, you can update a job's status to reflect where it is in the
overall production process. You can classify jobs as being "In Production" or "Completed".

• In Production: The job is still a work in progress. The other modules can still access this job.

• Completed: The job is finished. The Harmony database still has all the job's components (scenes,
elements, drawings), but the job neither appears nor is accessible from the Harmony applications.

In most cases, you would mark a job as "Completed" after it has been finalized (inked, painted,
rendered) and transferred to a medium such as tape or sent to post-production.

You can change a job's status from "Completed" to "In Production" at any time to continue
working on it.

If you want to remove a job and its data from the Harmony database and archive it, you can export the
job fromControl Center.

Before you send a job's scenes to be vectorized or rendered, you can change the job's priority level in
the processing queue. Increasing a job's priority lets the system process it before other jobs in the
processing queue.
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Use the ChooseNew Priority dialog box to change a job's rendering and vectorization queue priority.
The priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest.

For example, if job B is before job A in the queue, you can change the priority, so job A is processed
first.

Changing a job's priority does not affect vectorizing or rendering jobs that are already sent in the
queue. It will only affect jobs that are sent after making the change. If you want to change a job's
priority after it has been sent to the queue, use the Change Priority button in theQueuewindow.

You should only delete jobs that you no longer need or that have already been exported to an archive
(using the Export command available in the Adminmenu).

When you delete a job, the following components are permanently removed:

• Scenes

• Elements

• Drawings

• Database information associated with the selected job

• Palettes stored under the selected job

Before you delete a job:

• Make sure no one else is currently using the job. Failure to do this may result in file corruption and
loss of your work.

• Wait until everyone is offline. This ensures no one can open the data files while you delete them.

You cannot archive a job by deleting the job. If you want to archive a job, you should export it to a
new location where it can be stored permanently.

Changing the job's stage from In Production to Completed only hides the job in the Control Center
window; all the associated files with the job are still on your system.

You cannot delete a job if it still contains scenes.

How to create a job

1. In the Environments section, select the project in which you want to create a job.

2. Do one of the following:

‣ From the top menu, select Job > Create.

‣ Right-click in the Jobs section and select Create.

The Create Job dialog box appears.
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3. In the Name field, type the name of the job youwant to create.

The job name is alphanumeric and can include underscores (_), but no spaces or other special
characters. The job name is case-sensitive.

4. In the TD menu, select a technical director (TD). Youmust select a technical director to create the
job.

A TD is usually the person who oversees the animation project and makes sure the work is done
properly. Select the person who most closely resembles this definition. If you do not have a
particular user for the task, you can simply assign usabatch.

When you create your Harmony users, you can label a user as a technical director (TD).

5. In the ATD menu, select an assistant technical director (ATD). Youmust select an assistant
technical director to create the job. If you do not have an ATD, select the same person for the TD
and ATD jobs.

In some studios, the responsibilities of the technical director can be shared bymore than one
person. This second person is the ATD.

The technical director and assistant technical director you select appear in the Scenes list for each
scene of the job.

6. In the Approval menu, select how Harmony will mark the various stages the scenes will pass in your
production schedule.

‣ Automatic: When youwork on your scenes, Harmony automatically approves their status at
each stage

‣ Manual: When youwork on the scenes, the technical director or the assistant technical
director must approve their status at each stage using the Change Stage command
(available in the Scenemenu).

7. Drag the Priority slider handle to increase or decrease the job's priority (0means the job has the
highest priority for processing through the Vectorize or Render queue and a job with a priority of
10 is the least important). Jobs with higher priorities will pass in front of other projects with lower
priorities in the rendering and vectorizing queues even if there is already a queue processing.

If you do not know what priority to assign to your project, you can leave it at 5. You can always
change it later.

8. Click OK.

The Control Center module adds your new job to the selected environment and it appears in
alphabetical order in the Jobs list.
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How to change the stage of a job and view the list of completed jobs

1. In the Environments section, select an environment.

2. Do one of the following:

‣ From the top menu, select Job > Change Stage.

‣ Right-click in the Jobs section and select Change Stage.

The Change Stage of Jobs window appears.

3. Select the jobs you want to change the stage.

‣ If you want to change a job from In Production to Completed, select the jobs in the In
Production list.

‣ If you want to change a job fromCompleted to In Production, select the jobs in the
Completed list.

4. Click one of the Change buttons to change the job's status.

‣ Click the Change to Completed button to change a job that is in production.

‣ Click the Change to In Production button to change a job that is completed.

5. Click OK.

How to change a job's priority

1. In the Environments section, select the environment containing the job youwant to change the
priority for.

2. In the Jobs section, select the job whose priority you want to change.

3. Do one of the following:

‣ From the top menu, select Job > Change Priority.

‣ Right-click in the Jobs section and select Change Priority.

The ChooseNew Priority dialog box appears.

4. Drag the Priority slider handle to increase or decrease the job's priority (0means the job has the
highest priority for processing through the Vectorize or Render queue and a job with a priority of
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10 is the least important). Jobs with higher priorities will pass in front of other projects with lower
priorities in the rendering and vectorizing queues even if there is already a queue processing.

5. Click OK. When you send this job to be vectorized or rendered, it will have this new priority in the
processing queue.

How to delete a job

1. In the Environments section, select the environment containing the job youwant to delete.

2. In the Jobs section, select the job youwant to delete.

3. Do one of the following:

‣ From the top menu, select Job > Delete.

‣ Right-click in the Jobs section and select Delete.

The Confirm dialog box appears.

4. Click OK.

Managing Scenes
After you create a scene, you can view the corresponding elements and drawings in the Control Center
window. When you select the environment and the job, the corresponding scenes for the selected job
appears in the Scenes list in the Control Center window.

For each scene in your job, youmust create a unique exposure sheet to lay out the drawings, camera
effects, audio tracks, and other special effects for that scene.

When creating your scene, youmust select the path where you want to store the scene data and
where you want the new scene to appear in the Scenes list. You can create a single scene or create
multiple scenes all at once.

You do not have to enter the word "scene" when entering scene names. The system automatically
adds scene- in front of the name. For example, when you type"3" in the SceneName field, the scene
name automatically displays as "scene-3" throughout the file system. The scene namewill have "scene-
" as a prefix, but that will only be visible when looking at the scene on the file system. The scene will
appear without this prefix in all the Harmony applications.

When you delete a scene, you not only remove the scene from the Control Center window, but you
also permanently remove all the information associated with the scene including:

• Exposure sheet (and all associated versions)

• Elements

• Drawings

• Database information

• Any palettes stored in that scene's palette library

Before you delete a scene:
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• Make sure that you really want to remove all this information from the system

• Are you going to use the scene in the future?

• Do you need to archive the scene for future use?

• Make sure no one else is currently using the scene.

failure to do this may result in file corruption and loss of your work.

• Wait until everyone is offline. This ensures no one can open the scene while you delete it.

How to create a scene

1. In the Environments section, select the environment containing the job youwant to add scenes in.

2. In the Jobs section, select the job youwant to add scenes in.

3. Do one of the following:

‣ In the Scene section, select Scene> Create.

‣ Right-click in the Scenes section and select Create.

The Create Scene dialog box appears.

4. Click in the SceneName(s) field and enter the name for the first scene youwant to create.

5. Press the Enter/Return keyboard shortcut to move onto the next scene.

6. Enter the name of the next scene youwant to create.

When creating a new scene or renaming a scene, the scene's name cannot exceed 23
characters.

When creating scenes in the Control Center module, you should enter the scene names
exactly as they appear on the actual animation. This ensures that the information in your
environment is consistent with the actual animation.

The job and scene names are alphanumeric and can include underscores (_), but no
spaces, or other special characters. The environment name is case-sensitive.

7. Repeat the previous steps until you have named all the scenes you want to create.
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8. In the File System list, click the path where you want to store the files.

If you do not see the desired path in the list, specify a different path in theOther File System field.

If you are unsure which disk drive to select, consult your technical director or system administrator.

The information in the File System list displays:

‣ Available drives on which you can store new scenes

‣ Space that is currently available (in megabytes)

‣ The percentage of space the drives are currently using

Although you can add as many scenes as you wish, you can only select one path at a time. Therefore, the
Control Center module stores all scenes you create in one session at the same place (same path).

9. Select where you want to place the scene in the Scenes list from the Add Scenes menu. These are
the options:

‣ At Bottom: Places the new scenes at the bottom of the list

‣ At Top: Places the new scenes at the top of the list

‣ Before Selected: Places the new scenes before the selected scene

‣ After Selected: Places the new scenes after the selected scene

‣ Name Sort: Arranges the new scenes alphabetically.

To use the After Selected and Before Selected options, you must select another scene from the Scene list
in the Control Center window.

10. Click OK.

The new scene is created and displayed in the Scenes list. If you do not want to create the scene,
click Cancel.

How to delete a scene

1. In the Scenes list, select the scene name youwant to delete.
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2. Select Scene > Delete or right-click anywhere in the Scenes list and select Delete.

The Confirm dialog box appears.

3. Click Yes to delete the scene and all its related information.

The scene name and all its associated files are deleted.

Updating Scenes

Your scenes contain the animation sequences you are working with, which allows you to manipulate
them and their associated files to achieve the desired effect.

You can:

• Move a scene

• Rename a scene

• Change a scene's priority

• Change a scene's stage

• Change the sequence of a scene

• Clear scenes fromControl Center

• Copy an exposure sheet to another scene

• Send scenes to the render queue

When you create a scene, it and its associated files are stored on one drive. If you find you are running
out of space, you canmove a scene to another drive. However, you can consolidate all the scenes for a
particular job in a single directory allowing you to find related information quickly. Youmay also want
to file your scenes in specific directories, creating a customized directory system. TheMove command
lets youmove scene data from one file system to another.

Before youmove a scene's data:

• Make sure no one else is currently using the scene's data. Failure to do this may result in file
corruption and loss of your work.

• Wait until everyone is offline. This ensures no one can open the data files while youmove them.

As you work on your scenes, their nature and contents may change and the name you gave the scene
when you began the project may no longer reflect its contents. In this case, you can rename the scene
to more accurately reflect its contents.

Before you rename a scene:

• Make sure no one else is currently using the scene.

Failure to do this may result in file corruption and loss of your work.

• Wait until everyone is offline. This ensures no one can open the scene while you rename it.

You can change the scene's priority level in the processing queue. Increasing a scene's priority lets the
system process it before other scenes in the processing queue.
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Use the ChooseNew Priority dialog box to change a scene's rendering and vectorization queue
priority. The priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest. If a
scene has already been sent to the queue changing the priority at this point will not affect its priority in
the queue. Changes will only be applied next time it is sent to the queue. To change a scene's priority
after it's been sent to the queue, use the Change Priority button in theQueuewindow.

For example, If scene B comes before scene A in the queue, you can change the scene's priority so that
scene Awill be processed first.

The Change Stage command allows you to change the approval stage name of a selected scene that is
inManual approval mode. You can also create customized approval stages that reflect the approval
process in your production environment.

A scene's stage is a method of tracking its progress in your production; the scene's current stage
does not stop you from advancing the scene to other stages.

Changing a scene's stage andmaking manual approvals allows you to assign and change a scene's
approval stages to keep track of its current status. For example, if you have a scene whose drawings
are being scanned, you will mark it as the Scan stage. After you begin adding colour to these line
drawings, you can change the scene's stage to Paint. If the selected scene has an automatic approval
policy, the Change Stage command will be inactive in the Scenemenu. To change a scene's stage, you
must ensure that the approval policy is set to Manual.

You can change the sequence of scenes in your job, which affects the order in which the scenes appear
in the job throughout the system. You can place a scene anywhere in the Scenes list or you can sort
them alphanumerically.

If youmust restart a scene from scratch, you can completely erase a scene's exposure sheet. When you
clear a scene, you delete all exposure sheet database information and reset the scene as if it were
completely new. You are only deleting the files from the database; the Control Center module does
not actually delete any image files (drawings, scan, final frames). If you have questions concerning the
contents of a scene, you should contact the technical director responsible for the scene in question.

If youmust clear a scene from the Control Center module, make sure no one else is currently using the
scene's data. If you clear a scene that someone else is working on at that moment, you run the risk of
corrupting the files and losing work.

If youmust clear a scene, you should wait until everyone is offline to ensure that no one can open the
data files while you clear them from the Control Center module.

When you have two scenes with similar exposure sheet information, instead of entering the
information twice, you can:

1. Enter the information for one exposure sheet.

2. Copy it to the other scene.

3. Modify the second exposure sheet as needed.

The Copy command lets you copy an existing exposure sheet from one scene into another scene. You
can thenmodify the copied exposure sheet using Harmony Stage.

When you are ready to send a set of scenes for rendering, you can use the Send to Rendering
command. This command allows you to send one or more scenes for rendering to the Batch
Processing machine.

You can also use Harmony Stageto render scenes, but since youmust open each scene individually in
Harmony Stage, you can only send one scene to render at a time.
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How to move a scene from one directory to another directory

1. In the Scenes section, select the scenes you want to move.

2. Do one of the following:

‣ From the top menu, select Scene > Move.

‣ Right-click anywhere in the Scenes list and selectMove.

TheMove Scene dialog box appears.

3. In the Select Scene(s) to Move field, select the scenes you want to move from their current
directory.

4. Click Calculate to know how much hard disk space your selection requires.

5. In theMove Scenes To list, select the directory where you want to move the scene. If it does not
appear in the list, enter the directory path in theOther field.

The Control Center module automatically checks the amount of free space for each directory and
compares it to the size of the scene youwant to move.

If there is not enough disk space on a particular drive/mount point to store the scene, the directory
displays a not "enough spacemessage". Choose another disk from the list.

6. Click OK.

How to rename a scene

1. In the Scenes section, select the scene to rename.

2. Do one of the following:

‣ From the top menu, select Scene > Rename.

‣ Right-click anywhere in the Scenes list and select Rename.

The Rename Scene dialog box appears.
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3. In the Enter New SceneName field, type the new name for the scene and clickOK. Try to keep
scene names brief. It is recommended that you use no more than 23 characters.

Use lower case letters if these scenes may be used with a Windows workstation.

When creating a new scene or renaming a scene, the scene's name cannot exceed 23 characters.

How to change a scene's priority

1. Select the environment, the job and the scene youwant to prioritize.

2. Do one of the following:

‣ From the top menu, select Scene > Change Priority.

‣ Right-click anywhere in the Scenes list and select Change Priority.

The ChooseNew Priority dialog box appears.

3. Drag the Priority slider handle to increase or decrease the job's priority (0means the job has the
highest priority for processing through the Vectorize or Render queue and a job with a priority of
10 is the least important). Jobs with higher priorities will pass in front of other projects with lower
priorities in the rendering and vectorizing queues even if there is already a queue processing.

4. Click OK.

The new scene priority appears in the Scenes list in the Priority column.

How to change a scene's stage status

1. In the Scenes section, select a scene.

2. Do one of the following:

‣ From the top menu, select Scene > Change Stage.

‣ Right-click anywhere in the Scenes list and select Change Stage.

The Change Scene Stage dialog box appears.
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The current stage of the selected scene appears in the From Stage field.

3. Select the stage youwant to apply to the current scene from the To Stagemenu.

4. Click OK.

How to resequence a scene

1. Select the job whose scenes you want to re-sequence from the Jobs panel.

2. Do one of the following:

‣ From the top menu, select Scene > Reorder.

‣ Right-click anywhere in the Scenes list and select Reorder.

The Reorder Scenes dialog box appears.

3. Select the reordering method by clicking on the column headers or dragging the scenes up or
down.

4. Once the scenes are ordered, click OK.

How to clear a scene

1. Select the environment, job or scene youwant to clear.

2. Do one of the following:

‣ From the top menu, select Scene > Clear.

‣ Right-click anywhere in the Scenes list and select Clear.

The Confirm dialog box appears.
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3. Click OK.

The Scene list refreshes itself and displays blank elements and drawings lists, showing that the
Control Center module has deleted the exposure sheet for the scene you cleared.

How to copy an exposure sheet to another scene

1. Select the environment and the job from the Control Center window.

2. Do one of the following:

‣ From the top menu, select Scene > Copy.

‣ Right-click anywhere in the Scenes list and select Copy.

The Copy Scene dialog box appears.

3. Select the environment, job, and scene to copy from the exposure sheet from the From panel.

The lower half of the dialog box displays the environments, jobs, and scenes to which you can copy
the exposure sheet.

4. Select the environment, job, and scene where you want to copy the selected exposure sheet to the
To panel.

5. If you want to copy the associated animation data files with the scene's exposure sheet, select the
Copy All Data Files option. Harmony will place a copy of the animation data in the target scene's
storage directory.

6. Click OK.
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7. If the scene you are copying to already has an exposure sheet, a Confirm dialog box appears to
make sure you want to replace the existing exposure sheet.

‣ Click Yes if you want to copy over the existing exposure sheet.

‣ Click No to cancel the copy or to select a different scene.

The Copy Xsheet dialog box disappears. You can view andmodify the copied exposure sheet using
Harmony Stage.

How to send a group of scenes to the render queues

1. In the Control Center window, select the environment, job and scenes that you want to send to the
Render queue for rendering.

2. Do one of the following:

‣ From the top menu, select Scene > Send to Rendering.

‣ Right-click anywhere in the Scenes list and select Send to Rendering.

The Render Network dialog box appears.

3. Select the frames you want to render:

‣ All Frames: Sends all the frames in the scene to be rendered.

‣ Selected Frames: Sends a range of frames to be rendered. You can only send a range of
frames if you selected one scene.

4. Select theChunk option if you want to split the frames into sets of frames. Enter the number of
frames you want in each chunk in the Size field.

5. Select theVersion of the Scene youwant to render.

6. Select the camera you want to use to render the scene's images from the Camera menu. These are
the cameras you created in your exposure sheet in Harmony Stage.

7. If you want to create a Field Composite, select the checkbox to refine your selection.
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‣ Add Pulldown: Uses the 3:2 pulldown technique.

‣ Automatic Combine: Combines even and odd fields on a scene's image.

• Second Field First: Always start with the second field before combining with the first field.

8. If you did not select the Batch Composite Options option, select the Preview option to see the
render once it is completed.

9. Click OK.

To verify that the scenes have been sent for rendering, display the Render queue.

Viewing Elements and Drawings
Youmust use the Harmony Stage or Harmony Xsheet, instead of the Control Center, to add elements
or drawings to your environment. After you add them in the exposure sheet and save the source, the
Control Center module displays them in the Elements and Drawings panels.

When you select a scene in the Scenes list, all of the elements associated with the scene (background,
characters, etc.) appear in the Elements and Drawings lists. The Control Center module retrieves
these components from information you previously entered in the exposure sheet.

You can click the Expand/Collapse buttons to show or hide the Elements and Drawings sections.
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Exporting and Importing Data

With Harmony, you can import and export data.

You can use the Control Center module's export utility to migrate scenes from your system for archival
purposes or third parties, and you can use the import utility to integrate scenes into a Harmony
environment.

You can use the Control Center module's export utility to copy scene data. After Harmony copies the
exported data to a temporary directory, you canmove the archived data to your storage device (for
example, a CD or tape drive).

Harmony creates two files during export:

• README.txt: Includes export statistics, such as creation date and user ID

• IEContents.dat: Includes export parameters

In Linux, exporting your scenes using the Export commandmakes Harmony copy scene information
and link information to the temporary export directory you selected. Therefore, youmust retrieve the
animation data from your server and copy it, along with the database information, to your storage
device.

You can compress the export package to make it transportable. However, it will resolve hard links and
symbolic links, which might be contrary to your export options.

Copying the exported data to a storage device is a two-fold process. Copy the exported animation
files to a file on the storage device. Then remove the temporary export data from your system.

If the imported files are compressed, youmust decompress them to a temporary directory before you
can import them into Harmony. If you don't know how to decompress these files, see your system
administrator.

If you have any problems importing or exporting in Harmony, review the instructions to make sure you
have followed them completely. If you continue to have problems, consult the following list to
troubleshoot common import and export problems.

Problem: Import or Export Not Successful

If the transfer is not successful, an error dialog box appears to describe the problem. Themost
common reason for a failed transfer is due to your current network permissions. See your system
administrator for help.

If the transfer fails in themiddle of the process, the files that were imported or exported may be
corrupt or incomplete.

• For a failed import, use Control Center to delete the scene.

• For a failed export, manually delete the incomplete export folder.

If you click theMessage Log tab, you can seemore detailed descriptions, including error
messages.
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How to export data

1. Launch Control Center. To learnmore about the different launchmethods, see Starting the
Control Center on page 12.

2. From the top menu, select Admin > Export.

The Export Scene(s) dialog box appears.

3. Enter the path where you want to export the files. You can also use the Browse button to select
the path and create a folder. The destinationmust be an existing empty folder or a new folder that
will be created during the export process.

4. Click Add to select the scenes that you want to export from the Harmony database. You can select
a job to select all the scenes in the job. The scenes you select will appear in the list.

5. Select one or more scenes and click Remove to remove scenes from the export list.

6. In the Data Options tab, select what you want to export:

Parameter Description

Audio Exports the Audio directory.
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Databases

Selected by default, this option exports the elements
in the scene. If you select this option and deselect
the Elements option, you can access the elements from
the Element Manager in the Control Center, but their
drawing and bitmap files will not be included. The list
of available versions in the scene is also exported. It
will not be possible to open a scene if this is not
selected for export.

Final Frames
Exports the directory that contains final, rendered
frames.

Other Directories
Exports all other directories and files in the scene's
data structure.

Elements
Selected by default, this option exports the contents
(drawing and bitmap files) of the Element directories.

Timing Drawing
Selected by default, this option exports the contents
of the Timing directories.

Annotation
Allows you to export the different drawings created
while drawing in the Annotation columns and imported
images.

Stage (Xsheet and Network)

Selected by default, this option exports the Stage
directory, which contains the Stage files for each scene
you export. These files are necessary if you want to
have the ability to reuse the exposure sheet (timing)
and the effects network from the original scene. If this
option is selected, you can select theGet Outside
Drawings option to copy drawings into the scene
folder that is referred to by the Timing columns and
their Element (Drawing) modules.

Palettes

Exports the palette-library directories. When you
select this option, youmust decide if you want to
export the palette-library from the environment, job or
scene level. When you select a level, the palette-
library in lower-level directories will also be exported.

Macros
Exports themacros (customized effect and module
connections) that were created and stored in the
environment, jobs or scenes to be exported.

Libraries Exports templates created at the selected levels.

7. In the Advanced Options tab:

‣ Windows: Due to constraints in the operating system, you do not have any choices on the
Advanced Options tab. In Linux, you canmake the following selections.

‣ (MacOS X and Linux): Select how youwant to package the exported scene. The choices
youmake here are related to the size of the export package as well as the speed of the
export process. In Linux, you canmake the following selections.
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‣ Select one of the following options in the Exporting Files section:

Parameter Description

As hard links if possible, otherwise copy

Speeds up the export process bymaking hard
links to the original files on the file system. Hard
links keep disk space usage to a minimum and
ensure a quick export process.

If it is not possible to create hard links (because
the links cross file systems, for example), the
entire contents will be copied to the destination
directory, which will be a slower process that will
take up more space on your file system.
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As hard links when possible, otherwise
symbolic links

Ensures a quicker export process. However, if symbolic links
are used and the original file is deleted, the symbolic link will
be broken.

As symbolic links

Exports the scene using symbolic links to the original scene
files (when importing, imports the scene using symbolic links
to the export directory). While this process will reduce the
size of the export directory, if the original file is deleted, the
symbolic link will be broken.

Copy
Copies all scene data to the export location. This produces
the largest export package and therefore takes the longest
to complete. However, it is the simplest method.

8. In the Valid Links Options section, select one of the following options:

Parameter Description

Keep them Maintains symbolic links.

Resolve them
Removes symbolic links, replacing themwith the actual files.
When you use this option, the export package will contain
real files, rather than symbolic links.

Ignore them Does not include valid symbolic links in the export package.

9. In the Broken Links Options section, select of the following options:

Parameter Description

Keep them
Keeps symbolic links to missing files. When themissing files
are placed in the path searched by the symbolic link, broken
links will be valid again.

Ignore them
Does not include broken symbolic links in the export pack-
age.

10. Click Calculate to get a preview of the size of your export package.

11. Click Export.

The selected files and components are exported. Use theMessage Log tab to view messages
generated during the export process.

UnlikeWindows, where the database information and scene data have been copied to a different
directory, Linux creates a set of links to the data. Youmust use additional Linux commands to
retrieve the animation data pointed to by the links.

How to export your files to a storage device on Linux

1. Open a Linux shell and log in to themachine that connects to the storage device.

2. Copy the exported files using links from the source directory to the selected destination file. To
export to a file on a storage device, type the following command in a shell:

tb_backup_export_data -from [source_directory] -to [destination_
file] -writetarfile

‣ Where [source_directory] is the folder where the scene was exported to.
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‣ Where [destination_file] is the file that will be created by the tb_ backup_export_data
script.

3. After a successful copy of the exported data, remove the temporary export directory using the
following command:

tb_remove_export_data [export_directory]

‣ Where [export_directory] is the folder where the scene was temporarily exported to before
it was copied to the file or storage device.

How to import files into the Control Center module

1. Select Admin > Import.

The Import Scene(s) dialog box appears.

2. Any supported Stage file can be imported, including IEContents.dat files. The
IEContents.dat file includes database and scene file information. Specify the path of
IEContents.dat for the scene(s) you want to import.

3. Click Browse to select the environment, job and file systemwhere you want to place the imported
scene.
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4. If you want to import only some of the scenes in the Scenes to Import list box, select the scenes. If
no scenes are selected, all scenes will be imported.

5. In the Data Options tab, select what you want to import.

Parameter Description

Audio Exports the Audio directory.

Databases

Selected by default, this option exports the elements
in the scene. If you select this option and deselect
the Elements option, you can access the elements from
the Element Manager in the Control Center, but their
drawing and bitmap files will not be included. The list
of available versions in the scene is also exported. It
will not be possible to open a scene if this is not
selected for export.

Final Frames
Exports the directory that contains final, rendered
frames.

Other Directories
Exports all other directories and files in the scene's
data structure.

Elements
Selected by default, this option exports the contents
(drawing and bitmap files) of the Element directories.

Timing Drawing
Selected by default, this option exports the contents
of the Timing directories.

Annotation
Allows you to export the different drawings created
while drawing in the Annotation columns and imported
images.

Stage (Xsheet and Network)

Selected by default, this option exports the Stage
directory, which contains the Stage files for each scene
you export. These files are necessary if you want to
have the ability to reuse the exposure sheet (timing)
and the effects network from the original scene. If this
option is selected, you can select theGet Outside
Drawings option to copy drawings into the scene
folder that is referred to by the Timing columns and
their Element (Drawing) modules.

Palettes

Exports the palette-library directories. When you
select this option, youmust decide if you want to
export the palette-library from the environment, job or
scene level. When you select a level, the palette-
library in lower-level directories will also be exported.

Macros
Exports themacros (customized effect and module
connections) that were created and stored in the
environment, jobs or scenes to be exported.

Libraries Exports templates created at the selected levels.

51



Chapter 2: Control Center Module Exporting and Importing Data

6. In the Advanced Options tab, select how youwant to import the scene. Select one option in the
Valid Links Options and the Broken Links Options section.

7. Click Import.

If the scene already exists, the Scene Exists dialog appears.

8. Click Import Scene for each scene or Import All Scenes to confirm your selection.

9. Use theMessage Log tab to view messages generated during the import process.

If the name of the scene you are importing in Control Center is too long, you will be prompted with
an error message stating that it will be truncated. A scene's name cannot exceed 23 characters.

If you are importing scenes that were exported from the HarmonyNetwork, or worked on in
Harmony Stand Alone, the systemwill try to retrieve the version name.
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Control Center Commands

This section describes all the commands in the Control Center window.

Control Center Commands

The Control Center menu commands let you access the information about the application and quitting
onMacOS X.

Command Action Access Methods

About Toon
Boom
Harmony

MacOS X: Displays product, version,
licensing and copyright information.

Quit
MacOS X: Closes the Control Center
window and ends the current session.

⌘ + Q.

File Commands

The File menu commands let you access the Log file and exit the application onWindows/Linux.

Command Action Access Methods

Exit
Windows/Linux: Closes the Control
Center window and ends the current
session.

Ctrl + Q

View Log

Lets you view errors and warning
messages related to your actions
during the current Control Center
session.

Environment Commands

The Environment menu commands let youmanage the environments and queues.

Command Action Access Methods

Change
Asset Lock

Enables or disables the automatic
Global Lock on the scenes under the
selected Environment.

Right-click on the selected
environment in the Environments
list and select Change Asset
Lock.

Create
Opens a Create Environment dialog
box, where you can enter a name for a
new environment.

Right-click on the Environments
list and select Create.

Delete

Lets you delete an environment from
the database. You cannot delete an
environment unless it is empty; delete
all of the environment's scenes and
jobs before activating this command.

Right-click on the Environments
list and select Delete.
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Render
Queue

Opens the Render Queue dialog box
where you canmonitor and prioritize
the progress of the drawings that the
system is rendering.

Right-click on the Environments
list and select Render Queue.

Vectorize
Queue

Opens the VectorizeQueue dialog
box where you can display the
progress and prioritize the drawings
that the system is converting to the
TVG vector file format.

Right-click on the Environments
list and select Vectorize Queue.

Job Commands

The Jobmenu commands let youmanage the jobs and their state.

Command Action Access Methods

Change
Priority

Opens the ChooseNew Priority dialog
box where you can set the priority of
the rendering and vectorizing tasks for
one or more jobs. The priority is set
using a sliding scale where 0 is the
highest priority and 10 is the lowest.

Right-click on the Jobs list and
select Change Priority.

Change
Stage

Opens the Change Stage of Jobs
dialog box where you can record the
current stage of the environment's
jobs in the production process. You
can change the job from In Production
to Completed, or fromCompleted
back to In Production if you need to
perform further work.

Right-click on the Jobs list and
select Change Stage.

Create

Opens the Create Job dialog box
where you can add a new job to the
selected environment.

Your job must have a name that is
unique to the animation database (for
example, you cannot have two jobs
with the same name even if they exist
in different environments; they are all
in the same database).

Right-click on the Environments
list and select Create.

Delete

Removes a job from the selected
environment. When a job is deleted,
its scenes, elements, drawings, palette
library, and database information are
permanently removed. If you want to
archive a job, you should only delete
the job after you have used the
command to create the archive.

Before you activate this command,

Right-click on the Jobs list and
select Delete.
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verify that the selected jobs are not
currently in use.

Scene Commands

The Scenemenu commands let youmanage the scenes.

Command Action Access Methods

Change
Priority

Opens the ChooseNew Priority dialog
box where you can set the priority of
the rendering and vectorizing tasks for
one or more scenes. The priority is set
using a sliding scale where 0 is the
highest priority and 10 is the lowest.

Activating this command affects all
subsequent scenes you create. You
can change the priority of a scene
already sent to the batch processing
queue by using theChange Priority
button in the queue.

Right-click on the Scenes list and
select Change Priority.

Change
Stage

Opens the Change Scene Stage dialog
box where you can record the current
stage of progress in a scene in an
environment or a production.

This command is inactive if the scene's
approval policy has been set to
Manual in the Change Approval Policy
dialog box.

Right-click on the Scenes list and
select Change Stage.

Clear

Deletes a scene's exposure sheet.
Only exposure sheet files are deleted
from the database, not image files.

A delete confirmationmessage
appears, detailing the consequences
of using this option and requests that
you contact your Technical Director if
you are unclear about this procedure.

Before you activate this command,
make sure that all users are logged
out of Toon BoomHarmony and that
no files are currently in use.

Right-click on the Scenes list and
select Clear.

Copy Scene

Opens the Copy Scene dialog box
where you can copy a scene's
exposure sheet into another scene.
You can select a source and
destination scene in which to copy the
Xsheet data.

Right-click on the Scenes list and
select Copy.
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Create

Opens the Create Scene dialog box
where you can add one or more scenes
to the selected job. You can also
choose to:

• Add a scene from another file
system and add it to your job.

• Choose the position the scene
will take within the job.

Right-click on the Scenes list and
select Create.

Delete

Removes a scene from the database.
Before you activate this command,
make sure all users are logged out of
Toon BoomHarmony and that no files
are currently in use.

When a scene is deleted, its exposure
sheet, elements, drawings, palette
library and database information are
permanently removed. If you want to
archive a scene, you should only delete
the scene after you have used the
command to create the archive.

Before you activate this command,
verify that the selected scenes are not
currently in use.

Right-click on the Scenes list and
select Delete.

Force Unlock

Unlocks a scene was locked in
Harmony Stage. Generally, a scene
unlocks when it is closed by a user.
However, if a computer crashes while
a scene is locked and in use, a scene
may remained locked even if it is not
open.

An unlock confirmationmessage
appears detailing the consequences of
using this option.

If you activated this command for
more than one scene, you will be
prompted for confirmation to unlock
each scene separately.

Right-click on the Scenes list and
select Force Unlock.

Force Unlock
Version

Unlocks a version of a scene that has
been locked by Harmony Stage.
Generally, a scene unlocks when it is
closed by a user, however if a
computer crashes while a scene is
locked and in use, a scenemay
remained locked even if it is not open.

An unlock confirmationmessage
appears detailing the consequences of

Right-click on the Scenes list and
select Force Unlock Version.
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using this option.

If you activated this command for
more than one scene, you will be
prompted for confirmation to unlock
each scene separately.

Move

Opens theMove Scene dialog box
where you canmove one or more
scenes and their associated files to a
file location of your choice. TheMove
Scene command allows you to select
one or more scenes and calculate the
amount of space youwill need at the
new location to accommodate the
moved scene.

Before you activate this command,
make sure all users are logged out of
Toon BoomHarmony and that no files
are currently in use.

Right-click on the Scenes list and
selectMove.

Rename

Opens the Rename Scene dialog box
where you can enter a new name for
the selected scene. Before you activate
this command, verify that no users are
using the scene, all users are logged
out of Toon BoomHarmony and that
no files are currently in use.

Right-click on the Scenes list and
select Rename.

Reorder
Opens the Reorder Scenes dialog box
where you can change the sequence of
the scenes in a job.

Right-click on the Scenes list and
select Reorder.

Send to
Rendering

Opens the Composite dialog box
where you can add one or more scenes
to the rendering queue.

Right-click on the Scenes list and
select Send to Rendering.

Send to
Unvectorize

Opens the Send Scenes to Unvectorize
dialog box where you can convert a
scene's vector drawings into bitmap
drawings.

Right-click on the Scenes list and
select Send to Unvectorize.

Send to
Vectorize

Converts the Send to Vectorize
command to convert the selected
drawings to the TVG vector file
format.

Right-click on the Scenes list and
select Send to Vectorize.

Element Commands

The Element menu commands let you vectorize and unvectorize the elements.

Command Action Access Methods

Send to Opens the Send Elements to Right-click on the Elements list
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Unvectorize
Unvectorize dialog box and converts
an element's vector drawings into
bitmap drawings.

and select Send to Unvectorize.

Send to
Vectorize

Converts the drawings for the selected
elements to the TVG vector file
format.

Right-click on the Elements list
and select Send to Vectorize.

Drawing Commands

TheDrawing menu commands let you vectorize and unvectorize the drawings.

Command Action Access Methods

Send to
Unvectorize

Opens the Send Drawings to
Unvectorize dialog box and converts
selected vector drawings into bitmap
drawings.

Right-click on the Drawings list and
select Send to Unvectorize.

Send to
Vectorize

Vectorizes the selected drawings.
Right-click on the Drawings list and
select Send to Vectorize.

Admin Commands

The Adminmenu commands let you import and export scenes, and manage the users and approval
policy.

Command Action Access Methods

Change
Approval
Policy

Opens the Change Approval
Policy dialog box where you can
select a manual or automatic
approval of the production
status at each stage of each
scene.

Export Opens the Export Scenes dialog
box where you can transfer
copied data from the database
to a different directory.

You can also export scenes to
Stage (offline version) by
selecting Export Offline.

Import Opens the Import Scenes dialog
box where you can transfer
copied data from another
directory into the database.

Users Opens the User List dialog box
where you can display all valid
Toon BoomHarmony users in
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Command Action Access Methods

the network. You can add,
delete, or modify users in this
list.

Vectorize
Style

Opens the Vectorization Styles
dialog where you can select the
vectorization style you want to
apply to drawings before
sending them to the
vectorization queue.

Help Commands

The Help menu commands let you access the Help files and Control Center About information when
usingWindows/Linux.

Command Action Access Methods

Help Lets you view the Control Center
integrated help system.

F1

About Windows/Linux: Displays
product, version, licensing and
copyright information.
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Chapter 3: Harmony Cloud Module

HarmonyNetwork’s Control Center, fromwhich you canmanage your production database and
users, visualize your rendering queue andmore, is now available in a cloud-based format, so
freelancers and staff can download scene files, work on them, and upload them back again without
onsite assistance.

This chapter is divided as follows:

• Starting Harmony Cloud on the next page

• Harmony Cloud Interface on page 63

• Setting Up the User File Location on page 65

• Managing Users on page 66

• Managing Environments, Jobs and Scenes on page 74

• Scene Preview Clip on page 98

• Exporting and Importing Data on page 103

• User Profile
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Starting Harmony Cloud

Managing a production involving freelancers working for home or other studios requires the Harmony
Cloud module. The cloud is used to create new environments, jobs, scenes and users, as well as to
import and export scene packages. The cloud directly manages your server database. The cloud also
facilitates working from home and allows for an easy way to review rendered scene clips from
anywhere.

How to log into Harmony Cloud

1. Using your favourite browser, navigate to the URL you have allocated for Harmony Cloud during
installation.

‣ Example: www.toonboomcloud.com:8080 or localhost:8080

2. Enter your credentials and click Login. By default, there is a user name and admin (with the
password: admin). Be sure to change the admin password on your first login.

Harmony Cloud loads in the browser.
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Harmony Cloud Interface

The Harmony Cloud interface is divided into various tabs. Depending on your user type, you will see a
different number of tabs—seeManaging Harmony Users on page 18 details on user permissions.

You can collapse or expand the environments and/or jobs in themain DatabaseManagement tab of
Harmony Cloud. By clicking the button, you can show all jobs within an environment or all scenes
within a job.
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‣ R&D, Executive, Coordinator, Supervisor and TD users will see seven tabs as they are
considered to have administrative privileges.

‣ Animator, Archive, Xsheet, Scan and Ink&Paint users will see six tabs as they do not have
administrative rights.

Here is a typical example of the database structure:
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Setting Up the User File Location

Administrators will need to configure Harmony Cloud to allow users to import and export files. It is
necessary for the administrator to choose a directory where all user files will be stored. This directory
must then be configured in Harmony Cloud.

Harmony Cloud allows you to navigate to a scene and open a scene in Stage on your local computer.
Because Harmony Cloud is a web application, it is necessary for you to install the Java plugin to have
this functionality. You will also need to configure your Harmony Cloud user profile to specify which
local version of Harmony Stage youwant to use.

How to configure the directory

1. Navigate to your Cloud URL.

2. Log in as a user with Administrative privileges—see User Types and Restrictions on page 72.

3. Select theAdmin tab.

4. Select theConfiguration tab.

5. In the User Files Directory, enter the full path to the desired user files directory.

6. Click Save.

How to install the Java plugin

1. In your favourite web browser, visit the Java site to download themost recent version of the Java
Plugin for your browser.

‣ www.java.com/en/

2. Start the downloaded installer and follow the instructions on the screen to install the plugin.

Not all browsers on your computer require the same Java plugin. If, at some point, you experience issues
when switching to a different browser revisit the link and verify that you have a compatible version
installed on your computer.
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Managing Users

Each Harmony Cloud user will need to configure their profile to specify which version of Harmony
Stage they want to start when using the “Open in Stage” functionality in Harmony Cloud.

In a production environment, different Harmony users will tend to have different roles. In order to limit
functionality, users should be created in Control Center and/or in Harmony Cloud that reflect their
respective roles. For example, a user who is assigned to ink and paint should only have access to the
Paint module, and therefore should be created as a user with the type: ink and paint.

Everyone who uses Harmonymust have a login name in order to run any of themodules. Harmony
Cloud also requires users to have a secure password.

By default, only the admin user is created in Harmony Cloud.

TheManage Users tab lists all the users and their details, including; user name, first and last names,
and user type. The buttons at the top of the dialog box and the options on right-click let you add,
delete or modify the list of users.

Because Harmony Cloud requires a password, existing users (seen through the Control Center
interface) will need to be re-added through the Cloud interface. Doing so will simply update the user
information to make the user accessible to Cloud. When adding a brand new user through the Cloud
interface, that user will automatically have access to themodules such as Control Center, Stage, Paint,
Xsheet, Scan and Play if their user type allows it.

As your studio network grows and evolves, youmay need to delete old or obsolete user profiles from
your system. After you delete a user profile, the person who used that profile will no longer be able to
access any Harmonymodules including Harmony Cloud and Control Center.

You cannot delete yourself from the user list. If you accidentally delete a name, youmust follow the
procedures for adding a user to get the name back into the system.

You canmodify the user profiles at any time to update the user information. You will not be allowed to
modify or delete the admin user.

How to configure a user's profile

1. Locate the Stage executable on your local computer.

‣ Windows: C:\Program Files (x86)\Toon BoomAnimation\Toon BoomHarmony
11.1\win64\bin\Stage.exe

‣ MacOS X: /Applications/Toon BoomHarmony 11.1/Stage.app/Contents/MacOS/Stage

‣ Linux: /usr/local/ToonBoomAnimation/harmony_11.1/lnx86_64/bin/Stage

2. Navigate to your Cloud URL.

3. Log in as the user you want to configure.

4. Click My Profile.
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5. Select the Settings tab.

6. Paste the stage installation location from step 1 into the Stage install location field.

7. Click Save.

How to add a user

1. Make sure you are logged into Cloud as a user with Admin privileges—see See "Setting Up the
User File Location" on page 65.

2. Select theAdmin tab.

3. Select theManage Users tab.

4. Do one of the following:

‣ Click the button.

‣ Right-click anywhere in the user list and click Add.

The Add User dialog appears.
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5. Fill out all required fields.

6. Click AddUser to complete the update or click Cancel to abort.

The username cannot exceed the 12-character limit.
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The default minimum length required for a password is eight characters. You are
required to use three of the following class characters in your password. Capitalization
of the first letter of a word, or appending a number at the end, does not count.

• Lower case letters

• Upper case letters

• Numbers

• Other ASCII characters

• Unknowns (i.e. multibyte UTF-8 sequences)

How to delete a user

1. Make sure you are logged into Cloud as a user with Admin privileges—see See "Setting Up the
User File Location" on page 65.

2. Select theAdmin tab.

3. Select theManage Users tab.

4. In the user list, select the name youwant to delete.

5. Right-click and select Delete.

The confirm dialog appears.

6. Click Delete.
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How to modify user information

1. Make sure you are logged into Cloud as a user with Admin privileges—see See "Setting Up the
User File Location" on page 65.

2. Select theAdmin tab.

3. Select theManage Users tab.

4. In the user list, select the name youwant to modify.

5. Right-click and selectModify.

TheModify User Dialog will appear

6. Make your desired modifications.

7. Click on the Update User button to complete the update or click Cancel to abort.
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If you modify the username, make sure that it does not exceed the 12-character limit.

How to update the user password

1. Make sure you are logged into Cloud as a user with Admin privileges—see See "Setting Up the
User File Location" on page 65.

2. Select theAdmin tab.

3. Select theManage Users tab.

4. In the user list, select the name youwant to change the password for.

Type in your new password.

5. Click Save to complete the update.
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The default minimum length required for a password is eight characters. You are
required to use three of the following class characters in your password. Capitalization
of the first letter of a word, or appending a number at the end, does not count.

• Lower case letters

• Upper case letters

• Numbers

• Other ASCII characters

• Unknowns (i.e. multibyte UTF-8 sequences)

User Types and Restrictions
Here are the different user types available and their restrictions:

Feature
RND / Coordinator / Super-
visor / TD / Executive

Animator
Xsheet /
Archive

Scan
Ink &
Paint

Create Environment •
Change Asset Lock on Envir-
onment •

Delete Environment •

View VectorizeQueue • • • • •

View Render Queue • • • • •

Create Job • •

Change Job Priority • • • • •

Change Job Stage •

Delete Job •

Create Scene • • • •

Delete Scene •
Unlock scenes locked by
another user •

Unlock scene version locked
by another user •

Unlock scenes locked byme • • •
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Unlock scene version locked
byme • • •

Move Scene •

Rename Scene •

Clear Scene •

Change Scene Priority • • • • •

Change Scene Stage •

Reorder Scenes •

Copy Scenes • •

Send to Vectorize • • • • •

Send to Unvectorize • • • • •

Send to Rendering • • • • •

Add/Modify/Delete Users •

Change Approval Policy •

Change Vectorize Style • • • • •
Change Lock WhenOpening
Scene •

Database Lock Manager •

Export Scenes • • •

Import Scenes • • •

View Error Log • • • • •

View Elements • • • • •

View Drawings • • • • •

Open in Stage • • •

Open in Paint • • • •

Open in Scan • • • • •
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Managing Environments, Jobs and Scenes

Every project you create with the Harmony solution starts with an environment; it is your highest level
in the Harmony Cloud module. You can build a complete environment by adding jobs, scenes,
elements and drawings.

The Harmony Cloud module divides your animation project into the following categories which
organize the components of your animated projects:

• Environment: This is the name of your animation project.

Example: adventure_movie

• Jobs: These are themajor sections of an environment, such as sequences or episodes.

Example: adv_seq_001, adv_seq_002

All jobs are stored in the same location in the Harmony database. Be sure to prefix all job names
appropriately, so you can identify the project it belongs to. Each job must have a different name. You
cannot give two jobs the same name.

• Scene: These are the different shots in a job.

Scenes are contained in their respective job folder in the Harmony database. Prefix all scenes
names appropriately, so you can identify which environment and job they belong to.

Example: sc_001, sc_002
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• Elements: These are the different layers and columns in your scenes.

If you have not created an exposure sheet yet, the Frames column in the Scenes list displays 0 and
no elements appear in the Elements or Drawings list.

For example, scene 002 of show_episode_6 could have the following elements:

• A background called bg.

• A character called tony.

• A highlight effect called hl.

You would then find these elements under job 002 and the show_episode_6 scene. The
Elements list would display the element names, types of elements in a scene, the type of scans, and
the size of the field chart.

• Drawings: These are actual drawings of the elements (layers) in your scene.

For example, the tony element in 002 of show_episode_6 could consist of 35 drawings. To find
these drawings, you would look under Drawings to see the keyframes, state, and stage of each
drawing.

As your projects come and go, you will probably want to start cleaning up your database, as well as
your server's hard disk, by removing old and obsolete environments and their associated animation
data.

After you delete a scene, job, or environment, the associated data is permanently removed from
your storage disks. Make sure you really want to erase these items before you delete them as there is
no way to retrieve the data after it has been erased.

Youmight want to export old environments and archive them somewhere else before you delete them
from your system.

If you are working in a mixedWindows/Mac OS X/Linux environment or share files with other studios
that do, you should use lowercase letters to name the various items in your animation projects and
not include any spaces in component name. For example, write the_show instead of The Show. This
recommendation is due to the fact that Linux is case-sensitive while Windows is not.

Managing Environments
Harmony uses environments to manage and organize related projects. Using environments allows you
to organize your production projects by their nature or type.

If your projects center around episodic and commercial types of work, you can create two
environments. For example, there can be one called commercials and the other called the_show.
Then you can insert the jobs that relate to each type of project. When youwant to work on a
commercial project, open the commercials environment and select the commercial job you need.
Similarly, if you want to work on an episodic project, open the environment called the_show.
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Environment Job

commercials

dentist
sc_001

sc_002

soda sc_001

cereal sc_001

the_show

sho_001
sc_001

sc_002

sho_002 sc_001

dentist
sc_001

sc_002

How to create an environment

1. Select theDatabase tab.

2. Select theDatabase Management tab.

3. Do one of the following:

‣ Right-click anywhere in the Environments and Jobs section and click Create New
Environment.

‣ Click the Settings button and select Create New Environment.

TheNew Environment dialog appears.
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4. In the Name field, type the new project's name.

The environment name is alphanumeric and can include underscores (_), but no spaces or other special
characters. The environment name is case sensitive.

5. If you want the user to automatically get the rights to modify all the scene assets (drawing, scene
setup, palette lists, etc.), select the Get Rights toModify All Scene Assets option.

6. Click OK.

The new environment appears in alphabetical order in the Environments & Jobs list.

After you create an environment, youmust add it to the Batch Processing queue so that it can
vectorize and render the drawings and scenes automatically. You only have to add the environment
to the Batch Processing queue once.

Only certain user types can create an Environment—see Managing Users on page 66.

How to delete an environment

1. In the Environments & Jobs list, select the environment you want to delete.

2. Do one of the following:
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‣ Right-click and select Delete Environment.

‣ Click the Settings button and select Delete Environment.

The Delete Environment dialog box appears.

3. Click Delete.

The environment no longer appears in the Environments & Jobs list.

Only certain user types can create an Environment—see Managing Users on page 66.

Managing Jobs
Within each environment is a list of jobs. These jobs contain all the segments for your animated
sequence. If you are creating a weekly television series called The Show, you could name your job
show_ep_06 (the_show would be the name of your environment).

If each episode was composed of 100 animated shots, each job would contain 100 scenes.
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Each job must have a unique name. You cannot have two jobs with the same name, even if they appear
in two different environments. On the server, all the jobs are contained in the same folder.

As you continue working on your animation project, youmay want to update the status of the jobs in
your environment. This status can display one of three things:

• The stage the job has reached

• When the job will be vectorized

• When the job will be rendered

As you complete your animation project, you can update a job's status to reflect where it is in the
overall production process. You can classify jobs as being "In Production" or "Completed".

• In Production: The job is still a work in progress. The other modules can still access this job.

• Completed: The job is finished. The Harmony database still has all the job's components (scenes,
elements, drawings), but the job neither appears nor is accessible from the Harmony applications.

In most cases, you would mark a job as "Completed" after it has been finalized (inked, painted,
rendered) and transferred to a medium such as tape or sent to post-production.

You can change a job's status from "Completed" to "In Production" at any time to continue
working on it.

If you want to remove a job and its data from the Harmony database and archive it, you can export the
job fromControl Center.

Before you send a job's scenes to be vectorized or rendered, you can change the job's priority level in
the processing queue. Increasing a job's priority lets the system process it before other jobs in the
processing queue.

Use the ChooseNew Priority dialog box to change a job's rendering and vectorization queue priority.
The priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest.

For example, if job B is before job A in the queue, you can change the priority, so job A is processed
first.

Changing a job's priority does not affect vectorizing or rendering jobs that are already sent in the
queue. It will only affect jobs that are sent after making the change. If you want to change a job's
priority after it has been sent to the queue, use the Change Priority button in theQueuewindow.

You should only delete jobs that you no longer need or that have already been exported to an archive
(using the Export command available in the Adminmenu).

When you delete a job, the following components are permanently removed:

• Scenes

• Elements

• Drawings

• Database information associated with the selected job

• Palettes stored under the selected job

Before you delete a job:
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• Make sure no one else is currently using the job. Failure to do this may result in file corruption and
loss of your work.

• Wait until everyone is offline. This ensures no one can open the data files while you delete them.

You cannot archive a job by deleting the job. If you want to archive a job, you should export it to a
new location where it can be stored permanently.

Changing the job's stage from In Production to Completed only hides the job in the Control Center
window; all the associated files with the job are still on your system.

You cannot delete a job if it still contains scenes.

How to create a job

1. In the Environments & Jobs section, select the project in which you want to create a job.

2. Do one of the following:

‣ Click the Settings button and select Create New Job.

‣ Right click and select Create Job.

TheNew Job dialog box appears.

3. In the Name field, type the name of the job youwant to create.

The job name is alphanumeric and can include underscores (_), but no spaces or other special
characters. The job name is case-sensitive.
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4. In the TD menu, select a technical director (TD). Youmust select a technical director to create the
job.

A TD is usually the person who oversees the animation project and makes sure the work is done
properly. Select the person who most closely resembles this definition. If you do not have a
particular user for the task, you can simply assign usabatch.

When you create your Harmony users, you can label a user as a technical director (TD).

5. In the ATD menu, select an assistant technical director (ATD). Youmust select an assistant
technical director to create the job. If you do not have an ATD, select the same person for the TD
and ATD jobs.

In some studios, the responsibilities of the technical director can be shared bymore than one
person. This second person is the ATD.

The technical director and assistant technical director you select appear in the Scenes list for each
scene of the job.

6. In the Approvals menu, select how Harmony will mark the various stages the scenes will pass in
your production schedule.

‣ Automatic: When youwork on your scenes, Harmony automatically approves their status at
each stage

‣ Manual: When youwork on the scenes, the technical director or the assistant technical
director must approve their status at each stage using the Change Stage command
(available in the Scenemenu).

7. Drag the Priority slider handle to increase or decrease the job's priority (0means the job has the
highest priority for processing through the Vectorize or Render queue and a job with a priority of
10 is the least important). Jobs with higher priorities will pass in front of other projects with lower
priorities in the rendering and vectorizing queues even if there is already a queue processing.

If you do not know what priority to assign to your project, you can leave it at 5. You can always
change it later.

8. Click Save to complete the operation.

The Control Center module adds your new job to the selected environment and it appears in
alphabetical order in the Environments & Jobs list.

Only certain user types can create jobs—see Managing Users on page 66.
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How to change the stage of a job and view the list of completed jobs

1. In the Environments & Jobs section, select the job youwant to modify.

2. Do one of the following:

‣ Click the button and select Edit Job.

‣ Right-click and select Edit Job.

The Edit Job dialog box appears.

3. Make the desired modifications and click

4. Save to apply your changes.

‣ Cancel to abort your changes.

How to change a job's priority

1. In the Environments & Jobs section select the job youwish to modify.

2. Do one of the following:

‣ Click the button and select Edit Job.

‣ Right-click and select Edit Job.

The Edit Job dialog box appears.

3. Make the desired modifications and click Save.

How to delete a job

1. In the Environments & Jobs section select the job youwant to delete.

2. Do one of the following:

‣ Click the button and select Delete Job.

‣ Right-click and select Delete Job.

The Delete Job dialog box appears.
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3. Click Delete to delete the Job.

Only certain user types can create jobs—see Managing Users on page 66.

Managing Scenes
When creating a scene, youmust select the path where you want to store the scene data and where
you want the new scene to appear in the Scenes list. You can create a single scene or createmultiple
scenes at the same time.

When creating a new scene or when renaming a scene, the scene's name cannot exceed 23 characters.

When creating scenes in the Harmony Cloud module, you should enter the scene names exactly as they
appear on the actual animation. This ensures that the information in your environment is consistent
with the actual animation.

The job and scene names are alphanumeric and can include underscores (_), but no spaces, or other
special characters. The environment name is case sensitive.

You do not have to enter the word "scene" when entering scene names. The system automatically
adds scene- in front of the name. For example, when you type"3" in the SceneName field, the scene
name automatically displays as "scene-3" throughout the file system. The scene namewill have "scene-
" as a prefix, but that will only be visible when looking at the scene on the file system. The scene will
appear without this prefix in all the Harmony applications.

It is possible to configure your Harmony Clouduser account to allow for opening a scene in Stage
directly from the Cloud interface—see Setting Up the User File Location on page 65

How to create a scene

1. In the Environments & Jobs section select the job in which you want to add a scene.

2. Do one of the following:

‣ Click the Settings button and select Create New Scene.

‣ Right click and select Create New Scene.

TheNew Scene dialog box appears.
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3. In the Name field, enter the scene name.

4. In the File System list, click the path where you want to store the files.

‣ If you do not see the desired path in the list, specify a different path in the Filesystem field.

‣ If you are unsure which disk drive to select, consult your technical director or system
administrator.

The information in the File System list displays:

‣ Available drives on which you can store new scenes.

‣ Space that is currently available (in megabytes).

‣ The percentage of space the drives are currently using.

5. Select where you want to place the scene in the Scenes list

6. From the Add Scenes list, select where you want to place the scene in the Scenes list. These are the
options:

‣ At Bottom: Places the new scenes at the bottom of the list

‣ At Top: Places the new scenes at the top of the list

‣ Before Selected: Places the new scenes before the selected scene

‣ After Selected: Places the new scenes after the selected scene

‣ Name Sort: Arranges the new scenes alphabetically.

7. Click Save.

How to append multiple sequential scenes

1. In the Environments & Jobs section, select the job in which you want to add a scene.

2. Do one of the following:

‣ Click the Settings button and select Append Scenes.

‣ Right click and select Append Scenes.

The Append Scenes dialog appears. Fields in red aremandatory.
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3. Fill out the fields where the following is expected:

a. The number the first scene being appended should contain.
b. The prefix for each scene we are appending.
c. The number of zeroes to pad the scene number.
Example: The number 3 with padding of 4 would be 0003.

d. The suffix for each scene you append.
e. The number of scenes you want to append.
f. The file system list.
g. Add a file system that is not in the list.
h. Indicate where you want to place the scene in the Scenes list from the Add Scenes. You
have the following options :

‣ At Bottom: Places the new scenes at the bottom of the list.

‣ At Top: Places the new scenes at the top of the list.

‣ Name Sort: Arranges the new scenes alphabetically.

How to open a scene in Stage

1. Select theDatabase tab.

2. Select theDatabase Management tab.

3. Select an environment and then a Job.
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4. Select a scene from the Scenes list.

5. Right-click on the scene and selectOpen in Stage.

Updating Scenes

Your scenes contain the animation sequences you are working with, which allows you to manipulate
them and their associated files to achieve the desired effect.

You can:

• Move a scene

• Rename a scene

• Change a scene's priority

• Change a scene's stage

• Change the sequence of a scene

• Clear scenes fromControl Center

• Copy an exposure sheet to another scene

• Send scenes to the render queue

When you create a scene, it and its associated files are stored on one drive. If you find you are running
out of space, you canmove a scene to another drive. However, you can consolidate all the scenes for a
particular job in a single directory allowing you to find related information quickly. Youmay also want
to file your scenes in specific directories, creating a customized directory system. TheMove command
lets youmove scene data from one file system to another.

Before youmove a scene's data:

• Make sure no one else is currently using the scene's data. Failure to do this may result in file
corruption and loss of your work.

• Wait until everyone is offline. This ensures no one can open the data files while youmove them.

As you work on your scenes, their nature and contents may change and the name you gave the scene
when you began the project may no longer reflect its contents. In this case, you can rename the scene
to more accurately reflect its contents.

Before you rename a scene:

• Make sure no one else is currently using the scene.

Failure to do this may result in file corruption and loss of your work.
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• Wait until everyone is offline. This ensures no one can open the scene while you rename it.

You can change the scene's priority level in the processing queue. Increasing a scene's priority lets the
system process it before other scenes in the processing queue.

Use the ChooseNew Priority dialog box to change a scene's rendering and vectorization queue
priority. The priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest. If a
scene has already been sent to the queue changing the priority at this point will not affect its priority in
the queue. Changes will only be applied next time it is sent to the queue. To change a scene's priority
after it's been sent to the queue, use the Change Priority button in theQueuewindow.

For example, If scene B comes before scene A in the queue, you can change the scene's priority so that
scene Awill be processed first.

The Change Stage command allows you to change the approval stage name of a selected scene that is
inManual approval mode. You can also create customized approval stages that reflect the approval
process in your production environment.

A scene's stage is a method of tracking its progress in your production; the scene's current stage
does not stop you from advancing the scene to other stages.

Changing a scene's stage andmaking manual approvals allows you to assign and change a scene's
approval stages to keep track of its current status. For example, if you have a scene whose drawings
are being scanned, you will mark it as the Scan stage. After you begin adding colour to these line
drawings, you can change the scene's stage to Paint. If the selected scene has an automatic approval
policy, the Change Stage command will be inactive in the Scenemenu. To change a scene's stage, you
must ensure that the approval policy is set to Manual.

You can change the sequence of scenes in your job, which affects the order in which the scenes appear
in the job throughout the system. You can place a scene anywhere in the Scenes list or you can sort
them alphanumerically.

If youmust restart a scene from scratch, you can completely erase a scene's exposure sheet. When you
clear a scene, you delete all exposure sheet database information and reset the scene as if it were
completely new. You are only deleting the files from the database; the Control Center module does
not actually delete any image files (drawings, scan, final frames). If you have questions concerning the
contents of a scene, you should contact the technical director responsible for the scene in question.

If youmust clear a scene from the Control Center module, make sure no one else is currently using the
scene's data. If you clear a scene that someone else is working on at that moment, you run the risk of
corrupting the files and losing work.

If youmust clear a scene, you should wait until everyone is offline to ensure that no one can open the
data files while you clear them from the Control Center module.

When you have two scenes with similar exposure sheet information, instead of entering the
information twice, you can:

1. Enter the information for one exposure sheet.

2. Copy it to the other scene.

3. Modify the second exposure sheet as needed.

The Copy command lets you copy an existing exposure sheet from one scene into another scene. You
can thenmodify the copied exposure sheet using Harmony Stage.

When you are ready to send a set of scenes for rendering, you can use the Send to Rendering
command. This command allows you to send one or more scenes for rendering to the Batch
Processing machine.
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You can also use Harmony Stageto render scenes, but since youmust open each scene individually in
Harmony Stage, you can only send one scene to render at a time.

How to move a scene from one directory to another directory

1. In the Scenes section, select the scenes you want to move.

2. From the Settings menu, selectModify > Move.

TheMove Scene dialog box appears.

3. In theMove Scenes list, select the filesystemwhere you want to move the scene. If the directory to
where you want to move the scenes does not appear in the list, enter the new directory path in the
Filesystem field.

The Cloud module automatically checks the amount of free space for each directory and compares
it to the size of the scene youwant to move.

If there is not enough disk space on a particular drive/mount point to store the scene, the directory
displays a "not enough space" message. If there is not enough space on a particular disk, you
should choose another disk from the list.

4. Click OK.

How to rename a scene

1. In the Scenes section, select the scene to rename.

2. In the Settings menu, selectModify > Rename.

The Rename Scene dialog box appears.

3. In the Name field, type the new name for the scene and click Save. Try to keep scene names brief. It
is recommended that you use no more than 23 characters. Use lowercase letters if these scenes
may be used with a Windows workstation.

How to change a scene's priority

1. Select the environment, job and scene youwant to prioritize.

2. In the Settings menu, selectModify > Change Priority.

The Edit Scene dialog box appears.
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3. Drag the slider to the desired priority (0means the job has the highest priority for processing
through the Vectorize or Render queue and a Job with a priority of 10 is the least important).

4. Click OK.

How to change a scene's stage status

1. In the Scenes section, select a scene.

2. From the Settings menu, selectModify > Change Stage.

The Change Scene Stage dialog box appears.

The current stage of the selected scene appears in the From Stage field.

3. Select the stage youwant to apply to the current scene from the To Stagemenu.

4. Click OK.

How to resequence a scene

1. In the Scenes section, select a scene.

2. From the Settings menu, selectModify > Reorder.

The Reorder Scenes dialog box appears.

3. Select the reordering method by clicking on the column headers or dragging the scenes up or
down.

4. Once the scenes are ordered, click theOK.

How to clear a scene

1. In the Scenes section, select a scene.

2. From the Settings menu, selectModify > Clear.

The Clear Scene dialog box appears.
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3. Click OK to clear the data from the scene.

How to copy an exposure sheet to another scene

1. Select the scene youwant to copy.

2. From the Settings menu, select Create > Copy

The Copy Scene dialog box appears.

3. Select the environment, job, and scene youwant to copy to the selected exposure sheet.

4. If you want to copy the associated animation data files with the scene's exposure sheet, select the
Copy All Data option. Harmony will place a copy of the animation data in the target scene's
storage directory.

5. Click Copy.

6. If the scene you are copying already has an exposure sheet, a Confirm dialog box appears to make
sure you want to replace the existing exposure sheet.

‣ Click Yes if you want to copy over the existing exposure sheet.

‣ Click No to cancel the copy or to select a different scene.

How to send a group of scenes to the render queues

1. Select the environment, job and scenes you want to send to the Render queue.

2. From the Settings menu, select Batch > Send to Rendering.

The Render Scene dialog box appears.
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3. In the Range section, select the frames to render.

‣ All Frames: Sends all the frames in the scene to be rendered.

4. To split the frames into sets of frames, select theChunk option. In the Size (Frames) field, enter the
number of frames you want in each chunk.

5. In the Resolution section, set the resolution of the scene youwant to render, either by name or size
(value).

6. In the Field Composite section, select the Field Composite Option option to refine your selection.

‣ Add Pulldown: Uses the 3:2 pulldown technique.

‣ Automatic Combine: Combines even and odd fields on a scene's image.

‣ Second Field First: Always starts with the second field before combining with the first field.

7. Click OK.

8. To verify that the scenes have been sent for rendering, you can display the Render queue.

How to send a scene to the vectorization queue

1. Select the environment, job and scenes to send to the Vectorize queue.

2. From the Settings menu, select Batch > Send to Vectorize.

The Send to Vectorize dialog box appears.

3. Click Vectorize.

How to send a scene to be unvectorized

1. Select the environment, job and scenes to unvectorize.

2. From the Settings menu, select Batch > Send to Unvectorize.

The Unvectorize Scenes dialog box appears.
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3. AntialiasingQuality: Select the Antialiasing Quality and Antialiasing Exponent.

4. Resolution: Set the resolution to be as it was originally scanned (selected DPI value during the scan
process) or a specific width and height in pixels.

5. Output File Format: Select the output file format for your final bitmap images.

6. Command Line Options: Enter additional parameters.

7. Click OK.
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Vectorization and Render Queues

Before you can paint a scanned drawing in Harmony, youmust convert it to a vectorized image format.
The vectorizing process converts the drawings from a bitmap format to a vector line-based format.

Normally, when you scan drawings, Harmony automatically vectorizes them (sends them to the
Vectorize queue). However, you can also use the Send to Vectorize command to reprocess all
drawings for a particular element. Vectorizing prepares images for painting by creating vector files.
You would only have to manually send scenes to be vectorized in special cases such as:

• Processing images that were not scanned with the Scanmodule

• Reprocessing a scene due to unrecoverable paint errors

The Vectorize queue displays all the drawings the system is converting to a vector-based format. After
the vectorization of a drawing is finished, the completed drawing disappears from the Vectorize
queue.

The Render queue displays all the scenes from the selected environment that the system is rendering.
After the system renders a scene, the State of the rendered scene changes to Complete or Completed
with Errors, and the scene remains in the queue. If you want to remove the rendered scenes, youmust
select them and use the Delete button.

How to open the Render queue

1. Select theDatabase tab.

2. In the DatabaseManagement tab, go to the Environments & Jobs section.

3. Select the environment whose Rendering queue youwant to see.

4. Do one of the following:

‣ Click themenu button and select Render Queue.

‣ Right-click and select Render Queue.

The Render Queue tab for the selected environment opens.

5. Select the new Render <environment name> tab.
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6. Select how to sort the entries in the queue from the Sort By.

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing,
Completed with Errors, or Completed).

‣ Entry Time: Sorts the entries based on the time you sent them for rendering.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job id.

7. Select the components you want to display in the queue from the Show.

‣ Jobs: Select the specific job youwant to see.

‣ Scenes: Select the specific scene youwant to see.

8. Select the states you want to display in the queue from the Show States options.

‣ Pending: Displays the items waiting in the queue.

‣ Processing: Displays the items that currently processing.

‣ Completed: Displays completed items.

‣ Error: Displays the items that contains errors that stopped processing (displays Pending-E
as the item's state).

‣ Show All States: Displays all items, regardless of their state.

9. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs
field.

10. Select the Show Error Messages option to see any related errors for each entry in the queue.

If the Control Center module detects any errors while processing the scenes, it displays

Many of these errors can occur if the system is improperly configured. If you get a
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Pending-E error, see your system administrator as the systemmay need to be
reconfigured.

When you have a list of entries in your queue, you canmodify them in one of the following ways:

• Click theChange State to Pending button to change the status of the selected entries in the
queue from Processing to Pending. After a job becomes Pending, the next availablemachine will
process the entry.

If you want to remove the entry from the queue, select the Pending entry and click Delete. If the
entry is processing, you can delete the entry from the queue but the processing will not stop until
it is completed.

You can only modify an entry in the queue while it is pending (check the State column in the queue
list). You cannot modify a job that is being processed.

• Click theChange Priority button to change the selected drawings' processing priority in the
queue. When theNew Priority dialog box appears, increase or decrease the drawing's priority.

• Click theDelete button to delete the selected drawings from the queue. When you remove a
drawing from the queue, the request is cancelled only.

How to open the Vectorization queue

1. Select theDatabase tab.

2. In the DatabaseManagement tab, go to the Environments & Jobs section.

3. Select the environment whose Rendering queue youwant to see.

4. Do one of the following:

‣ Click themenu button and select Vectorize Queue.

‣ Right-click and select Vectorize Queue.

The VectorizeQueue tab for the selected environment opens.

5. Select the new Vectorize <environment name> tab.
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6. Select how to sort the entries in the queue from the Sort By.

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing,
Completed with Errors, or Completed).

‣ Entry Time: Sorts the entries based on the time you sent them for rendering.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job id.

7. Select the components you want to display in the queue from the Show.

‣ Jobs: Select the specific job youwant to see.

‣ Scenes: Select the specific scene youwant to see.

8. Select the states you want to display in the queue from the Show States options.

‣ Pending: Displays the items waiting in the queue.

‣ Processing: Displays the items that currently processing.

‣ Completed: Displays completed items.

‣ Error: Displays the items that contains errors that stopped processing (displays Pending-E
as the item's state).

‣ Show All States: Displays all items, regardless of their state.

9. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs
field.

10. Select the Show Error Messages option to see any related errors for each entry in the queue.
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If the Control Center module detects any errors while processing the scenes, it displays
"Pending-E" in the State column. Errors can occur if there are files missing, computers
are unavailable, or data cannot be found.

Many of these errors can occur if the system is improperly configured. If you get a
Pending-E error, see your system administrator as the systemmay need to be
reconfigured.

When you have a list of entries in your queue, you canmodify them in one of the following ways:

• Click theChange State to Pending button to change the status of the selected entries in the
queue from Processing to Pending. After a job becomes Pending, the next availablemachine will
process the entry.

If you want to remove the entry from the queue, select the Pending entry and click Delete. If the
entry is processing, you can delete the entry from the queue but the processing will not stop until
it is completed.

You can only modify an entry in the queue while it is pending (check the State column in the queue
list). You cannot modify a job that is being processed.

• Click theChange Priority button to change the selected drawings' processing priority in the
queue. When theNew Priority dialog box appears, increase or decrease the drawing's priority.

• Click theDelete button to delete the selected drawings from the queue. When you remove a
drawing from the queue, the request is cancelled only.
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Scene Preview Clip

It is possible to view the preview clip for a scene fromHarmony Cloud. It is also possible to configure
Harmony Stage to automatically render a video and image to be set as the Cloud preview clips.

Here are the image and clip formats supported by Harmony Cloud:

• bmp

• gif

• jpg

• mov

• png

• tif

How to view a preview clip

1. Select theDatabase tab.

2. Select theDatabase Management tab.

3. Select an environment and then a job.

4. Select a scene from the Scenes list.

5. Right-click and select See Preview or click the button.

How to set up automatic creation of the Cloud Write node

1. Run Harmony Stage in databasemode.

2. SelectWindows > Script Editor to enable the Script Editor view.
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3. From the list of scripts, select TB_CloudIntegrationConfigure.js.

4. From the view menu, select Play/Debug > Run.

The Run dialog box opens.

5. From the Files list, select TB_CloudIntegrationConfigure.
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6. From the Functions list, select TB_CloudIntegrationConfigure.

7. Click OK.

8. Select the Enable Cloud Integration for Preview Images andMovies option.

9. Click OK.

How to create a preview image of the current frame

1. Run Stage in databasemode.

2. Right-click on the toolbar of your choice and select Customize.

3. In the Available Tools panel, locate the tb_cloud_thumbnail_render in TB_Cloud_
Thumbnail_Render.js script.

4. Click theMove Right button.
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5. Click Apply.

6. Click OK.

The new button appears in your toolbar.

How to render a movie clip for Cloud

1. From the top menu, select File > Export > Render Network.

2. In the Batch Composite Options (Resolution) section, select the By Name option and then select
Cloud_Preview.
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How to render a preview image for Cloud

1. In Harmony Stage, go to the Camera view .

2. Select the frame youwant to render in your timeline.

3. Click the script button you added to your toolbar—see How to create a preview image of the
current frame on page 100.
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Exporting and Importing Data

Exporting and importing from the Harmony Cloud is also an easy way to work from home in offline
mode and then import your changes back into the Harmony database.

Using the Harmony Cloud module's export utility, you canmigrate scenes from your system for
archival purposes or third parties, and use the import utility to integrate scenes into a Harmony
environment.

You can also copy scene data. This exported data can be downloaded through the Harmony Cloud
interface to your local PC or you can store the exported scene in your Harmony Cloud user files for
download access later.

Harmony Cloud creates two files during the database export process:

• README.txt file (includes export statistics, such as creation date and user ID)

• IEContents.dat file (includes export parameters)

Harmony Cloud creates one file during the offline export process:

• IEContentsOffline.txt file (includes export parameters used to re-import data)

The exported package will be a compressed file in the zip format. You will need to unzip it prior to opening it
in Harmony Stage.

When importing, Harmony Cloud expects a compressed file in zip format of either an individual offline
scene or a package exported in databasemode.

You must compress the package directory in zip format on your local machine before you can import it into
the Cloud.

How to export data

1. Select theDatabase tab.

2. Select the Export tab.

3. Expand the environment and job that holds the scenes you want to export.

4. Select the scene(s) you want to export from the Database view on the left.

5. Do one of the following:

‣ Drag and drop the scene into the Scene(s) to Export pane.

‣ Click the Export button.
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6. In the Export To section, select the destination for the export.

‣ Download: Downloads the exported package to your local file system immediately.

‣ My Files: Stores the exported package in your Harmony Cloud user files on the Harmony
Cloud server—see Exporting and Importing Data on page 45.

7. Select one or more scenes and click Remove to remove scenes from the export list.

‣ If you chose the Export Offline option, you also have the choice of performing a checkout
on the scene. This locks the scene which persists as you work offline. When you import the
scene back into the Harmony database and check in, the lock will be released.

8. In the Data Options tab, select what you want to export:

Parameter Description

Audio Exports the Audio directory.

Databases

Selected by default, this option exports the elements
in the scene. If you select this option and deselect
the Elements option, you can access the elements from
the Element Manager in the Control Center, but their
drawing and bitmap files will not be included. The list
of available versions in the scene is also exported. It
will not be possible to open a scene if this is not
selected for export.

Final Frames
Exports the directory that contains final, rendered
frames.

Other Directories
Exports all other directories and files in the scene's
data structure.

Elements
Selected by default, this option exports the contents
(drawing and bitmap files) of the Element directories.

Timing Drawing
Selected by default, this option exports the contents
of the Timing directories.
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Annotation
Allows you to export the different drawings created
while drawing in the Annotation columns and imported
images.

Stage (Xsheet and Network)

Selected by default, this option exports the Stage
directory, which contains the Stage files for each scene
you export. These files are necessary if you want to
have the ability to reuse the exposure sheet (timing)
and the effects network from the original scene. If this
option is selected, you can select theGet Outside
Drawings option to copy drawings into the scene
folder that is referred to by the Timing columns and
their Element (Drawing) modules.

Palettes

Exports the palette-library directories. When you
select this option, youmust decide if you want to
export the palette-library from the environment, job or
scene level. When you select a level, the palette-
library in lower-level directories will also be exported.

Macros
Exports themacros (customized effect and module
connections) that were created and stored in the
environment, jobs or scenes to be exported.

Libraries Exports templates created at the selected levels.

9. Click Calculate to get a preview of the size of your export package.

10. Click Export.

The selected files and components are exported. 

How to import files into Harmony Cloud

1. Select theDatabase tab.

2. Select the Import tab. Only zip files of an individual scene exported offline or a database package
export can be imported.

3. Do one of the following:

‣ Click the Choose File button and select the zip package youwant to import from your local
machine.

‣ Click the Import button and choose from your uploaded Harmony Cloud files.

4. Click the Browse button to select the environment, job and file systemwhere you want to place the
imported scene.

5. In the Data Options tab, select what you want to import:

Parameter Description

Audio Exports the Audio directory.

Databases
Selected by default, this option exports the elements
in the scene. If you select this option and deselect
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the Elements option, you can access the elements from
the Element Manager in the Control Center, but their
drawing and bitmap files will not be included. The list
of available versions in the scene is also exported. It
will not be possible to open a scene if this is not
selected for export.

Final Frames
Exports the directory that contains final, rendered
frames.

Other Directories
Exports all other directories and files in the scene's
data structure.

Elements
Selected by default, this option exports the contents
(drawing and bitmap files) of the Element directories.

Timing Drawing
Selected by default, this option exports the contents
of the Timing directories.

Annotation
Allows you to export the different drawings created
while drawing in the Annotation columns and imported
images.

Stage (Xsheet and Network)

Selected by default, this option exports the Stage
directory, which contains the Stage files for each scene
you export. These files are necessary if you want to
have the ability to reuse the exposure sheet (timing)
and the effects network from the original scene. If this
option is selected, you can select theGet Outside
Drawings option to copy drawings into the scene
folder that is referred to by the Timing columns and
their Element (Drawing) modules.

Palettes

Exports the palette-library directories. When you
select this option, youmust decide if you want to
export the palette-library from the environment, job or
scene level. When you select a level, the palette-
library in lower-level directories will also be exported.

Macros
Exports themacros (customized effect and module
connections) that were created and stored in the
environment, jobs or scenes to be exported.

Libraries Exports templates created at the selected levels.

6. If you are importing a standalone scene which was checked out, you will also have the option to
check-in the scene.

7. Click Import.

If the scene already exists, the Scene Exists dialog appears.

8. Click either Import Scene for each scene or Import All Scenes to confirm your selection.
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If the name of the scene you are importing in Harmony Cloud is too long, you will be prompted with an
error message stating that it will be truncated. A scene's name cannot exceed 23 characters.

If you are importing scenes that were exported from Harmony Network or worked on in Harmony Stand
Alone, the system will try to retrieve the version name.

Troubleshooting Import or Export Problems
If you have any problems exporting or importing in Cloud, review the instructions to make sure you
have followed them completely. If you continue to have problems, consult the following list to
troubleshoot common import and export problems.

• Import or Export Not Successful: If the transfer is not successful, an error dialog box appears to
describe the problem. Themost common reason for a failed transfer is due to your current
network permissions. See your system administrator for help. If the transfer fails in themiddle of
the process, the files that were imported or exported may be corrupt or incomplete.

• For a failed import: Use Control Center or Harmony Cloud delete the scene.

• For a failed export: Manually delete the incomplete export folder.
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Chapter 4: Batch Processing
The Toon BoomHarmony system uses batch processing to convert scanned drawings to a vector-
based format or to render the final animation. The system performs these tasks in the background;
you will not even realize the system is performing the tasks.

There are two types of batch processes in Harmony; both can run on almost any computer on the
network: vectorize and render.

Vectorize
The vectorizing process prepares the images scanned on the black and white scanner for painting by
converting them to vector based files (*.tvg files). The vectorizing process converts the drawings
from a bitmap format to a digital line-based format.

Vectorizing prepares images for painting by creating paint files. You would only have to manually send
scenes to be vectorized in special cases such as:

• Processing images that were not scanned in the Scanmodule

• Reprocessing a scene due to unrecoverable paint errors

• Completing the vectorization after you run the scene through a pencil test

You can open the VectorizeQueue in the Control Center module for the list of vectorizing work
waiting to be processed.

Render
Also known as compositing, this process composites scenes to create the final frames.

When you have finished working on a scene or all of your animated sequences, you can render it out
locally or send it to the Render Queue. After you render your animation, you can transfer the scenes
to video or film.

You can open the Render Queue in the Control Center module for the list of compositing work
waiting to be processed by a rendering machine.

Setting Up the Batch Processing
When you create a new environment for a project, youmust set up the batch processing. You can
create a particular batch processing schedule and assign certainmachines on your Harmony network
to vectorize and render the scenes in that environment.

Youmust set up batch processing on selected Harmonymachines to convert scanned drawings to
vector files and to composite final frames.

We do not recommend rendering/vectorizing on the workstation while you are working in the
software. These tasks are resource intensive and will slow your computer down if you are trying to
work in the software at the same time. If urgently needed on a continual basis, set up a separate
render station to do this. Otherwise, batch processing should be done while the workstation is
inactive.
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With Harmony batch processing, you can spread the workload across multiple computers on the
network, creating a render farm. To do this, youmust identify all the computers that will be
processing Harmony files and you have to start the batch processing queues. Then, you have to set up
all the environments you add to the database for batch processing.

Once you have set up batch processing, you can send your drawings to be vectorized and scenes to be
rendered. This chapter also explains how to view the Vectorize and Render queue to check on how the
batch processing is progressing.

This chapter is divided as follows:

• Installing Batch Processing and Configuring themachine-list File on the facing page

• Creating themachine-list File (Linux) on page 116

• Installing Batch Processing and Configuring themachine-list File () on page 1

• The tbprocess Program on page 117

• Setting Up Default Schedules on page 124

• Testing Batch Processing on page 126

• Troubleshooting on page 136

• Advanced Batch Processing on page 139

• Vectorizing Scenes or Elements on page 127

• Rendering Scenes on page 130

• Stopping a Process on page 133
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Installing Batch Processing and Configuring the machine-list File

The machine-list file identifies all themachines on your network that can be allowed to batch
process Harmony files. Themachines on this list represent the render farm.

Youmust have sufficient batch processing licenses to run batch processing on all themachines in the
machine-list file.

Windows
InWindows, use the Harmony ConfigurationWizard to add computers to themachine-list file and to
install the batch processing service. Youmust run the ConfigurationWizard on all machines that will
perform batch processing.

How to start the Harmony Configuration Wizard

1. Click the Start menu and select All Programs > Toon Boom Harmony 11.1 > Tools >
Configuration Wizard.

The Toon BoomHarmonyConfiguration window opens.

How to configure batch processing

1. In theWizards section, click Batch Processing.

2. In the next window, you are asked if this machine will do batch processing. Select Yes and click
Next.
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3. In theWhat is the Name of the Server field, enter the name of the Harmony server.

4. In theWhat is the User field, type the server's user name (OS account) created while setting up the
Harmony database. Themachine you are setting up will use this user name and password to log on
the server machine and retrieve the data to render or vectorize.

5. In theWhat is the Password field, type the password corresponding to the selected user name.

6. Click Next.

The Harmony Configuration wizard presents a review of all the changes that will bemade.

7. Click Finish.
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Mac OS X
OnMacOS X, use the Configuration Assistant to install the batch processing queue Startup Item that
will start the batch processing service. Youmust run the Configuration Assistant on all machines that
will perform batch processing.

How to install the batch processing queue Startup Item

1. In the Finder, go to Applications > Toon Boom Harmony 11.1 > Tools > Configuration
Assistant.

2. Select theCreate the Startup Items option and click Continue.

3. Select theCreate Queue Server Startup Item option and click Create.

The Authenticate dialog box appears asking for a user name and a password.

4. Type a user namewho is allowed to administer the computer and click OK.

The necessary files to automatically start the batch processing queue on the counter are copied.

5. Repeat these steps on all the computers that will be performing batch processing.
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The files required to start the batch processing queue are copied by the Configuration Assistant in:

/Library/StartupItems/ToonBoomQueueServer/ folder.

A dialog box appears to indicate if the Startup Itemwas successfully created.

6. Click OK.

The Finish window appears.

7. Click Done to close the Configuration Assistant.

Machine-list File

Themachine-list file identifies all themachines on your network that are allowed to batch process
Harmony files. Themachines in this list represent the render farm. Youmust have sufficient batch
processing licenses to run batch processing on all of themachines in themachine-list file.

How to create the machine-list file

1. In a text editor, create a new text file.

2. In the new text file, enter all themachine names in your render farm.

The order that you list machine names determines their order in the batch processing scheduling
commands.

There must be no blank lines in the machine-list file.
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For example, your machine-list might look like this:

anim-1

anim-2

anim-3

bart-1

bart-2

paint-1

paint-2

paint-3

‣ Your machine name is created when you install MacOS X. You can list themachine name of
a computer by typing the following command in the Terminal or command prompt:

hostname

3. Save the file with the namemachine-list in the /USA_DB/schedules/ directory.
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Creating the machine-list File (Linux)

The machine-list file identifies all of themachines on your network that can be allowed to batch
process Harmony files. Themachines on this list represent the render farm.

Youmust have sufficient batch processing licenses to run batch processing on all of themachines in the
machine-list file.

How to create the machine-list file on Linux

1. Using a text editor, create a new text file. Enter all of themachine names in your render farm in this
file. The order that you list machine names in this list determines their order in the batch processing
scheduling commands.

There must be no blank lines in the machine-list file.

For example, your machine-list might look like this:

anim-1

anim-2

anim-3

bart-1

bart-2

paint-1

paint-2

paint-3

Your machine name is created when you install Linux. You can list themachine name of a computer
by typing the following command in a terminal or command prompt:

uname -n

2. Save the file with the name machine-list in the /USA_DB/schedules/ directory.
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The tbprocess Program

The tbprocess programmonitors the database queues for batch processing work to be done. When it
finds a batch processing job to complete, it launches the appropriate Vectorize or Render programs
to process the job (you canmonitor these jobs using the queues in the Control Center module. In
order for a machine to perform the batch processing, youmust launch the tbprocess program on it.

You can use a set of schedules to better manage the batch processing on your Harmony system. While
scheduling dictates the type and time a machine will perform batch processing, the tbprocess
program does the actual batch processing work (for both vectorize and render batch processing).

There are several ways in which you can start the tbprocess program on a machine and then verify that
it is indeed running. You can run only one session of tbprocess per machine. If you try to runmore than
one tbprocess session, nothing happens (the first session keeps running). You canmonitor the jobs
taking place in the tbprocess session by opening the log file.

Remember that just because tbprocess is running on a machine, it does not mean that the
machine is actually doing any batch process work at that moment. The schedules
determine the location and timewhen themachines perform batch processing work.

This section is divided as follows:

• Starting the Batch Processing Queue onWindows below

• Starting the Batch Processing Queue on Linux on page 119

• Starting the Batch Processing Queue onMacOS X on the next page

• Verifying that a tbprocess Session is Active on page 121

• Monitoring a tbprocess Session on page 122

Starting the Batch Processing Queue on Windows
When you launch a Harmonymodule, there are functions that applications perform in the background
that you generally do not see. Two of these functions are as follows:

• tbprocess: Manages requests for batch processing of vectorized drawings or rendered scenes.

When you ran the Harmony ConfigurationWizard, you had the option of having batch processing
on your system. If you selected the Yes option and you have a valid license, the tbprocess starter is
ready to run; otherwise, you cannot perform batch processing on Harmony.

• tbdbserver: When you have a Server/Standalone configuration, the tbdbserver controls the entries
that youmake to the Harmony database (like adding new scenes to a job).

When you run the Toon Boom Harmony Configuration Wizard, it automatically configures your system to
launch the tbdbserver, so you do not need to configure anything else.
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How to modify the Process Starter launch properties

1. From the Start menu, select Control Panel from the Settings sub-menu.

The Control Panel window appears.

2. Double-click on the Toon BoomHarmony Control Panel icon in the Control Panel window.

The Toon BoomHarmony Control Panel dialog box appears.

3. Select the Process Starters tab. You can use this tab to select a specific process starter and view
its parameters.

The Process Starters tab displays the following information:

‣ User: Displays the profile that the process starter uses by default.

‣ Password: Displays the password for the user specified in the User field.

‣ Command Line: Displays the path of the application you want the process starter to
launch.

‣ Log File: Displays the name of the log file that records all themessages from the application
specified in the Command Line field.

‣ WorkingDirectory: Displays the path that contains all the applications you need and where
these applications can store data while they run.

4. Make anymodifications you need to the existing services and click Update parameters button.

5. Click OK.

Starting the Batch Processing Queue on Mac OS X
After themachine-list file has been created and the Startup Item has been installed, you are ready to
start the batch processing queue. The Startup Itemwill start the batch processing queue automatically
every time the computer is started, but you can start it without restarting the computer.

Note that the user must have administrator privileges on the computer.

How to start batch processing queues

1. Open theMacOS X Terminal application.
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2. Go to Applications > Utilities > and double click on the Terminal.

3. Type the following in the Terminal:

sudo /sbin/SystemStarter start ToonBoomQueueServer

The Terminal prompts you to type your password.

How to stop batch processing queues

‣ Type the following in the Terminal:

sudo /sbin/SystemStarter stop ToonBoomQueueServer

The Terminal prompts you to type your password.

Starting the Batch Processing Queue on Linux
After themachine-list file is created, you are ready to start the batch processing queues. Youmust
start the batch processing queues on all machines that will perform batch processing.

How to start batch processing queues

‣ Type the following in the Terminal or command prompt:

/sbin/service USAnimation_queues start

Amessage appear in the shell indicating that the script was successful.

The tbprocess program is installed with the Toon BoomHarmony system. It monitors the Vectorize
and Render batch processing queues for work to be done and runs the appropriate programs to
vectorize or render the images.

If you reboot your machine after you install the Toon BoomHarmony, the tbprocess program starts
automatically on each Toon BoomHarmony client and server.

During a normal installation, Harmony places a file called S98USAnimation_
queues in the /etc/rc2.d/ folder. This file controls the launching of the
tbprocess programwhen you reboot.

This file name S98USAnimation_queues may change and the first two
numbers at the beginning of the file name could be:
S97USAnimation_queues,S96USAnimation_queues,
S95USAnimation_queues and so on.

If you do not see this file in the /etc/rc2.d/ folder, you need to reinstall the
links for Harmony. However, if you do not reboot after you install the Toon
BoomHarmony system, or someone stops the tbprocess program on a specific
machine, youmust start the tbprocess program on eachmachine assigned to the
batch processing schedule before you can batch process the items in the
Vectorize or Render queues.
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How to launch the tbprocess program on a batch processing machine

1. Open a command prompt and log in as the root user on themachine onwhich you want to start
the Process program.

2. Type the following:

/etc/init.d/USAnimation_queues stop

3. Press Return to make sure there are no tbprocess programs already running.

Type /etc/init.d/USAnimation_queues start

4. Press Return.

A PID (Process ID) number appears when the tbpprocess starts.

[1] 19003

To stop the Process program on a machine, type /etc/init.d/USAnimation_queues stop
and press Return.

5. To view the batch processing schedule status for all machines, type Status and press Return.

The batch processing schedule appears.

The column on the left displays an R for eachmachine onwhich you launched the tbprocess
program.
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Verifying that a tbprocess Session is Active
There are two commands you can use to verify that tbprocess is running on a machine. To use any of
these commands, type the one youwant to use in a Command Shell or Terminal and press
Enter/Return.

• Status command

This command allows you to view the Schedule Status—seeDisplaying the Schedule Status on
page 140. If tbprocess is running on a machine, an R appears in the R column for that machine.

Windows

InWindows, the process can be verified from:

• Toon Boom Harmony Control Panel: Control Panel > Toon BoomHarmony Control Panel

• Services panel: Control Panel > Administrative Tools > Services panel

Mac OS X

• ps -axc | grep roc command

This command verifies if you have a tbprocess session running on a machine.

• -a displays information about other users' processes as well as your own.

• -x displays information about processes without controlling terminals.

• -c changes the "command" column output to contain just the executable name, rather than the
full command line.

A list of all the processes running appears:

The ps command is a Linux statement used to report active processes. There are a variety of options
and arguments that you can run with this command to limit or alter the information that appears. The
arguments used with the ps command in this document are only suggestions. Refer to your Linux
manuals for more information on the different options and arguments available with the ps command.

Linux

• ps –f –u usabatch | grep roc command

This command verifies if you have a tbprocess session running on a machine.

• –f produces a fully-detailed list of information.

• –u usabatch lists only information by the user usabatch.

Sincemore than one user can start the tbprocess program, you can view a more complete list by
removing the -u usabatch parameter from the command. You can also replace this parameter
by –efa to view all the processes on themachine, regardless of the user (except the processes
that are not linked to an Command shell).
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• -grep roc searches for commands that contain the letters “roc”. This allows you to search for
Process sessions only.

A list of all the processes running for usabatch appears:

Monitoring a tbprocess Session
As the tbprocess program batch processes jobs, you can see which one are being processed and
which ones are waiting in the queue. This is handy in case you want to remove old jobs from the queue
because youmade changes to them, or if you want to change the processing priority in the jobs.

There are two ways to monitor the tbprocess session:

• Using theQueuewindows in the Control Center module.

The easiest way to monitor a tbprocess session on a particular machine is to open the Vectorize or
Render queues using the Control Center module.

• Typing the ssh and tail commands in a Linux shell.

When checking a machine's Vectorize or Camera queues, remember that if themachine is scheduled to
perform processing work for multiple environments, youmay need to search both queues in several of
the environments to get a complete picture of what is happening.

Viewing Specific Events in the tbprocess Session

Windows: If you want to check the log on theWindows machines in your network, youmust access the
machines themselves and view the tbprocess.log file in a text editor. Some text editors require
that you stop the tbprocess session before you open the log file because it locks the file while
recording.

MacOS X: As the Process session vectorizes jobs, it stores them in a log file. You can find the log files
in /Library/Logs/ToonBoomQueueServer.log file.

Linux: As the Process session vectorizes jobs, it stores them in a log file. You can find the log files in
/tmp/tbprocess.log file.

Viewing tbprocess Events on One Machine (Linux and Mac OS X)

If you want to view the tbprocess jobs for a specific machine, you can remotely log in to that machine
view the entries in the tbprocess.log file as they get added.

You need to use the two following commands to view these entries:

• ssh: Allows you to connect remotely to another machine and launch a specified command. The
remote connection stays open for the duration of the command and then closes, ending the
connection.

• tail: Displays the latest 10 lines of the specified file as they appear.

To view the entries in the tbprocess.log file as they occur, open a shell or Terminal and type:

Linux:

ssh machine tail -n -10 -f /tmp/tbprocess.log
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MacOS X:

ssh machine tail -n -10 -f /Library/Logs/ToonBoomQueueServer.log

• machine is the name of themachine running the tbprocess you want to monitor.

• -n 10 instructs the tail command to display the latest line of the file (you can change this value if
you want).

• -f instructs the tail command to update the display as the file changes.

When using the tail command with the -f option, youmust use [Ctrl] + [C] to quit the command.
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Setting Up Default Schedules

When you first set up your Harmony system, it is a good idea to set up a default batch processing
schedule. You canmodify this schedule later based on the operating needs of your studio.

If you have not created any environments, there will not be any environments for you to start up.

Youmust start up a default schedule for every environment you create in the Harmony database.

Maintaining a limited number of environments will make it easier to set up and manage batch processing
queues. For example, you can create four environments, like test, commercials, and one environment per
features or series.

How to define the default batch processing schedule

1. Open a command prompt or Terminal and type:

Setdef

Follow the onscreen instructions to set up the environment for batch processing by selected
machines on the Harmony network.

2. Enter themachine name onwhich you want to set up batch processing:

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all

‣ Type all  to create a default schedule for all machines in themachine-list or press
Enter/Return to create a schedule only for themachine you are currently using.

3. If you enter only onemachine name, decide if you want to addmoremachines to process this
environment.

DO YOU WANT TO INPUT MORE MACHINES

‣ Type y and press Enter/Return if you want to enter moremachines or press Enter/Return if
you do not want to enter anymoremachines.

4. Identify the type of work this machine will be doing: vectorizing, rendering or both.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed

‣ Type y if this machine will vectorize drawings.

is camera work allowed

‣ Type y if this machine will render scenes.

‣ Identify the environments this machine will process.

INPUT A SET OF DATABASE Environments

‣ Type the number (not the name) for each environment you want to set up on this machine
and press Enter/Return. A space (or a comma) must separate each environment number.

should processing of the dbenv's be prioritized

5. You can prioritize the environments based on the order you entered them in the previous step.
Typically, you will not want to prioritize environments like this.
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‣ Type n and press Enter/Return if you do not want to prioritize environments.

6. Turn the input on for themachine

input ON or OFF

‣ Press Enter/Return to turn the input on.

When you are done, a status message appears indicating that themachine is set up for batch
processing using the default schedule.

7. To view the batch processing schedule status for all machines, type the following:

Status

8. Press Enter/Return twice to get the report.

Themachines that are set up to batch process should appear in the report. Theremust be an R
next to themachine name and the status must beOn to be able to batch process.
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Testing Batch Processing

To verify that batch processing is working, send a few frames from a scene to be rendered by the
Harmony Stagemodule.

How to test batch processing

1. Open the Control Center and select the environment and job that contains the scene to render.

2. Select the scene, right-click on the sample scene in the Scene panel and select Send to Rendering.

The Render Network dialog box opens.

3. In the Range section, select the Selected Frames option and type 1 to 5 in the From and To fields.
Leave the rest of the default options and click OK.

An alert appears indicating that the scene was sent to the queue.

4. Click OK to close the alert.

5. Open the Render Queue to see if your scene is being processed.

6. In the Environments section, select the environment containing the scene that is rendering.

7. From the top menu, select Environment > Render Queue.

The Render Queuewindow opens. You should see the sample scene listed. Its state will change
from "Pending" to "Processing" and then to "Completed" after it has been rendered.
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Vectorizing Scenes or Elements

Before you can paint a scanned drawing in Harmony, youmust convert it to a vectorized image format.
The vectorizing process converts the drawings from a bitmap format to a vector line-based format.

Normally, when you scan drawings, Harmony automatically vectorizes them (sends them to the
Vectorize queue). However, you can also use the Send to Vectorize command to reprocess all
drawings for a particular element. Vectorizing prepares images for painting by creating vector files.
You would only have to manually send scenes to be vectorized in special cases such as:

• Processing images that were not scanned with the Scanmodule

• Reprocessing a scene due to unrecoverable paint errors

The Vectorize queue displays all the drawings that the system is converting to a vector-based format.
After the vectorization of a drawing is finished, the completed drawing disappears from the Vectorize
queue.

How to manually vectorize all the drawings for a scene or an element

1. Select the scene from the Scenes list or select an element from the Elements list.

If you selected a scene, Harmony vectorizes all drawings for all elements of that scene.

If you selected an element, Harmony vectorizes all the drawings for that selected element.

2. Depending on the component you selected, do one of the following:

‣ From the Scenemenu, select the Send to Vectorize command or right-click anywhere in the
Scenes list and select Send to Vectorize.

‣ From the Element menu, select the Send to Vectorize command or right-click anywhere in
the Elements list and select Send to Vectorize.

The Confirm dialog box appears.

3. Click Yes to vectorize all the selected drawings.

The Control Center module sends all drawings in the scene or element to the Vectorize queue. To
verify how the processing is progressing, you can display the vectorize queue.

How to view the list of drawings being vectorized

1. Select an environment name from the list, then select Environment > Vectorize Queue.

The VectorizeQueuewindow appears.
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2. From the Sort Bymenu, select how to sort entries in the queue:

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing, or
Completed)

‣ Entry time: Sorts the entries based on the time you send them for vectorization.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job ID.

3. If the Vectorize queue has too many entries, you can select a specific job, scene, element, or
drawing that is in the queue. Select the items youwant to display in the queue from the Show
menu, which displays all items in the Control Center module's database, not just the ones that have
drawings being vectorized.

‣ Jobs: Selects the specific job in the queue or one that has scenes currently being vectorized.
To see all the jobs, select All Jobs.

‣ Scenes: Selects the specific scene that is in the queue or currently being vectorized. To see
all the scenes in a job, select All Scenes.

4. Select the states you want to display in the queue from the Show States options:

‣ Pending: Displays the items waiting to be vectorized.

‣ Error: Displays the items where the system found an error and has stopped vectorizing
them (displays Pending-E as the item's state).

‣ Processing: Displays the items that the Harmony is currently processing.

‣ Completed: Displays the items that were vectorized. However, the Control Center module
usually removes completed items from the Vectorize queue, so this option is inactive.

‣ Show All States: Displays all the items, regardless of their state.

5. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs
field.

6. To see any related errors for each entry in the queue, select the Show Error Messages option.

If the Control Center module detected any errors while it prepares the drawings, it displays
Pending-E in the State column. These errors can occur if there are files missing, computers are
unavailable, or data cannot be found.
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Most of these errors would occur if the system is improperly configured. Therefore, your system
administrator needs to reconfigure the system to correct the error. If you get a Pending-E error, see your
system administrator.

Modifying Entries in the Vectorize Queue

When you have a list of entries in your queue, you canmodify them in one of the following ways:

• Click theChange State to Pending button to change the status of the selected entries in the
queue from Processing to Pending. After a job becomes Pending, the next availablemachine will
process the entry.

If you want to remove the entry from the queue, select the Pending entry and click Delete. If the
entry is processing, you can delete the entry from the queue but the processing will not stop until it
is completed.

You can only modify an entry in the queue while it is pending (check the State column in the queue
list). You cannot modify a job that is being processed.

• Click theChange Priority button to change the selected drawings' processing priority in the
queue. When theNew Priority dialog box appears, increase or decrease the drawing's priority.

• Click theDelete button to delete the selected drawings from the queue. When you remove a
drawing from the queue, the request is cancelled only.
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Rendering Scenes

When you have finished working on a scene or all of your animated sequence, you can send them to
the Render queue via Control Center or Harmony Stage. After you render your animation, you can
transfer the scenes to video or film.

After rendering a scene, you canmark it as completed using the Change Stage command in the Scene
menu. After you render all the scenes for a particular Job, you canmark the Job as completed using
the Change Stage command in the Jobmenu.

Changing the job's stage from In Production to Completed only hides the job in the Control Center
window.

Viewing the Render Queue
The Render queue displays all the scenes from the selected environment that the system is rendering.
After the system renders a scene, the State of the rendered scene changes to Complete or Completed
with Errors and the scene remains in the queue. If you want to remove the rendered scenes, youmust
select them and use the Delete button.

How to view the scenes being rendered

1. Select an environment name from the list, then select Environment > Render Queue.

The Render Queuewindow appears.

2. Select how to sort the entries in the queue from the Sort By.

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing,
Completed with Errors, or Completed).
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‣ Entry Time: Sorts the entries based on the time you sent them for rendering.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job id.

3. Select the components you want to display in the queue from the Show.

‣ Jobs: Select the specific job youwant to see.

‣ Scenes: Select the specific scene youwant to see.

4. Select the states you want to display in the queue from the Show States options.

‣ Pending: Displays the items waiting in the queue.

‣ Processing: Displays the items that currently processing.

‣ Completed: Displays completed items.

‣ Error: Displays the items that contains errors that stopped processing (displays Pending-E
as the item's state).

‣ Show All States: Displays all items, regardless of their state.

5. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs
field.

6. Select the Show Error Messages option to see any related errors for each entry in the queue.

If the Control Center module detects any errors while processing the scenes, it displays
"Pending-E" in the State column. Errors can occur if there are files missing, computers
are unavailable, or data cannot be found.

Many of these errors can occur if the system is improperly configured. If you get a
Pending-E error, see your system administrator as the systemmay need to be
reconfigured.

Modifying the Entries in the Render Queue

After you have a list of entries in your queue, you canmodify them in one of the following ways:

1. Change their state in the queue. This allows you to update the status of a scene, or set of scenes, in
the queue from Processing (whichmeans it is being rendered) to Pending (whichmeans the scenes
are waiting to be rendered). After you set a job to Pending, the job remains in the queue until a
machine becomes available and takes the job or you delete it from the queue.

‣ Click theChange State to Pending button to change the status of the selected entries in the
queue from Processing (or Completed) to Pending.

2. Change the scene's processing priority. This allows you to change the order in which the system
renders the scenes.

‣ Click Change Priority to change the selected scene's processing priority in the queue.

‣ When theNew Priority dialog box appears, use the scroll bar to increase or decrease the
scene's render priority.

3. Remove scenes from the Render queue. This allows you to cancel the render command on selected
scenes.
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‣ Click theDelete button to delete the selected entries from the queue.

You can only modify an entry in the render queue while it is pending (check the State column in the
queue list); you cannot modify a job that is being rendered.

If youmust change something about the scene's drawings, youmust wait until the rendering is
complete. Thenmake your changes and send it to the Render queue.

If you absolutely must stop the rendering process, you can kill the render process in Windows, Linux or Mac
OS X.
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Stopping a Process

DONOT STOP THE PROCESS UNLESS ABSOLUTELYNECESSARY.
An example of an extreme case is if you sent 10,000 drawings for vectorization and
only onemachine is available to handle the job (whichmeans it will take hours to
complete).

DONOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If youmust stop
a process, see your system administrator.

After you send a scene's drawing for vectorization or rendering, you can remove it from the queue
easily. If the process is pending in Vectorize or Render queue (check the State column in the queue list),
you can simply remove it by selecting the job and clicking theDelete button in the Vectorize/Render
Queuewindow.

But once the vectorizing or rendering process actually begins, it gets a bit more complicated to stop
the process. If you really must stop a vectoring or rendering job, youmust remove it from the
Vectorize or Render queues and then find the actual process in your Windows Task Manager, MacOS
XActivityMonitor or Linux Shell and kill each task manually.

Stopping a Windows Process

DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
system administrator.

How to stop a vectorize or render process on a computer running Windows

1. In the Vectorize/Render Queuewindow, select the job youwant to stop and click Delete.

2. Right-click on theWindows task bar and select TaskManager.

The Task Manager dialog box appears.

3. Select the Processes tab.
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4. Vectorizing or rendering starts a process named AnimatePro.exe. Locate it and select it.

5. Click End Process.

TheTask Manager stops the process and removes it from the Processes tab.

If you stop a process, but do not delete the job from the Vectorize or Render queue, the queue marks the
entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to remove the
entry from the queue before you stop the process.

Stopping a Linux Process

DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
system administrator.

How to stop a vectorize or render process in Linux

1. Select the job to stop from the Vectorize/Render Queuewindow and click Delete.

2. As the root user, open a Linux shell and type:

ps -fe.

The shell window displays all the processes that are active at themoment.
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3. Find the listing for the vectorizing or rendering process that you started. There are two ID flags to
look for:

‣ If you started a vectorizing process, look for the process that lists the word Pix2vec -
file fileLocation.

‣ If you started a rendering process, look for the process that lists the word Stage -job
jobName -scene sceneName -version versionNumber.

4. Take note of the system number that identifies the process. In the example above, the system
numbers appear in the box on the left.

5. Type the following command and replace <id number> with the system number you noted in the
previous step:

kill -9 <id number>

For example, if your process number is 5348 or 5353 (as in the example above), you would type the
following command to stop the process:

‣ kill -9 5353: Stops the vectorize process.

‣ kill -9 5348: Stops the rendering process.

6. Press Enter/Return.

If you stop a process, but do not delete the job from the Vectorize or Render queue, the queue marks the
entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to remove the
entry from the queue before you stop the process.
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Troubleshooting

If you have any problems running Harmony after installation, review the installation and configuration
instructions to make sure you have followed them completely. If you continue to have problems,
consult the following list to troubleshoot common installation and configuration problems.

• Problem: No Batch Vectorization or Rendering (Windows) below

• Problem: No Batch Vectorization or Rendering (MacOS X) on the facing page

• Problem: No Batch Vectorization or Rendering (Linux) on the facing page

Problem: No Batch Vectorization or Rendering (Windows)

If drawings are not being vectorized or rendered you should check the status of batch processing
machines.

How to check the status of the batch processing machines

1. From the Start menu, select All Programs > Accessories > Command Prompt.

2. In the command prompt window, type Status and press Enter twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next
to themachine name and the status must be "On" to be able to batch process.

‣ If machines aremissing from the report, run theHarmony Configuration Wizard to set up
batch processing on eachmachine that will vectorize drawings or render scenes—see
Installing Batch Processing and Configuring themachine-list File on page 111

‣ If a machine is in the report, but is set to "Off", youmust define a default schedule for the
machine—see Setting Up Default Schedules on page 124

‣ If a machine is in the report, but is missing the "R", restart the batch processing queues.

How to restart the batch processing queues

1. From the Start menu, select Control Panel from the Settings sub-menu.

The Control Panel window appears.

2. Double-click on the Toon BoomHarmony Control Panel icon in the Control Panel window.

The Toon BoomHarmony Control Panel dialog box appears.

3. From the Process Starter menu, select tbprocess-schedule.

4. Click Start restart the service. If the Start button is disabled, click Stop first, wait a couple of
seconds, and then click Start.
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If you continue to have problems with batch processing, locate the tbprocess.log file and send it to
support@toonboom.com. This file is usually in: \Program Files\Toon Boom
Animation\Harmony\nt

Problem: No Batch Vectorization or Rendering (Mac OS X)

If drawings are not being vectorized or rendered you should check the setup and configuration of
batch processing.

How to check the status of the batch processing machines

1. In the Terminal, type Status and press Enter/Return twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next
to themachine name and the status must be "On" to be able to batch process.

‣ If no machines appear in the list, make sure the /USA_DB/schedules/machine-list file
lists all of the computers that will do batch vectorization or rendering. Try resending
elements to the Render queue.

‣ If your machine appears in the list, but that there is no "R" next to it, the tbprocess service
may not be running. Verify that the tbprocess is active—see Verifying that a tbprocess
Session is Active on page 121.

‣ If there is no tbprocess session active, perhaps the processes were not installed when you
installed configured your installation. Verify that the ToonBoomQueueServer folder exists
in the /Library/StartupItems folder. If it does not, see The tbprocess Program on
page 117.

‣ If the folder exists, start the tbprocess session by typing
sudo /sbin/SystemStarter start ToonBoomQueueServer
The Terminal prompts you to type your password. Your user needs to be allowed to
administer this computerin order for this command to work.

Problem: No Batch Vectorization or Rendering (Linux)
If drawings are not being vectorized or rendered you should check the setup and configuration of
batch processing.

How to check the status of the batch processing machines

1. In a shell, type Status and press Enter/Return twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next
to themachine name and the status must be "On" to be able to batch process.

‣ If no machines appear in the list, make sure the
/USA_DB/schedules/machine-list file lists all the computers that will perform batch
vectorization or rendering. Try resending elements to the Render queue.

‣ If you still have problems vectorizing and rendering, perhaps the processes were not
installed when you installed Harmony. Reinstall Harmony running the -p option. In a shell,
change to the directory where the installation script is stored and type:

./install -p

‣ Make sure that the queues are started. Type the following:

/sbin/service USAnimation_queues start
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To learn more about the Linux installation process, refer to the Toon Boom HarmonyLinux Installation
Guide.
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Advanced Batch Processing

Once the basic vectorization and rendering batch processing is started, there aremore advanced
options possible such as advanced scheduling.

This section is divided as follows:

• About Batch Processing Schedules below

• Setting Up Default Schedules on page 124

• Displaying the Schedule Status on the next page

• Using Default Schedules on page 143

• Using Periodic Schedules on page 147

• Using Supervisory Schedules on page 153

• Shutting Down and Starting Up Environments on page 158

• A Summary of Scheduling Commands on page 161

About Batch Processing Schedules
By creating a schedule to monitor the batch processing, you can determine whichmachines perform
the batch processing and when they do it. Each batch processing machine on your network has its own
set of schedules and you can view andmodify them from anymachine on the network.

There are three types of schedules available for a machine:

• Supervisory Schedule: Assigns a one-time batch processing job to a machine. For example, you
can define a Supervisory schedule for a machine to perform batch processing work for the next
four hours.

Of the three types of schedules, Supervisory schedules have the highest priority. If you define a
Supervisory schedule for a specific period of time on a machine, it will perform the batch
processing work according to that schedule, regardless of what the Periodic and Default schedules
define for that period of time.

• Periodic Schedule: Assigns recurring batch processing jobs. For example, you can define a
Periodic schedule for a machine to perform batch processing only on Saturdays and Sundays.

Periodic schedules use the days of the week, so you can have batch processing occurring each
week on specific days.

In terms of priority, a Periodic schedule supersedes a Default schedule, but not a Supervisory
Schedule. If there is a Periodic schedule active on a machine, then it performs this type of batch
processing according to its Periodic schedule before it uses the Default schedule.

• Default Schedule: Defines which jobs themachine can process if there are no other schedules
defined. Default schedules have the lowest priority, and are used only when Supervisory and
Periodic schedules are not present or do not define the work to be done for a particular period of
time.

When creating or modifying a schedule, youmust supply the following information:
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• Dates and times for which the schedule applies

• Machine(s) for which the schedule applies

• Whether batch processing is ON or OFF (whether that machine does or does not perform batch
processing work)

• The type of batch processing to be done: Vectorize and/or Rendering

• The environments for which batch processing processes the artwork

• The priority of the environments to be batch processed (optional)

For any givenmachine, you can define, clear and view the Supervisory and Periodic schedules. You can
only modify or view the Default schedule for a machine.

You can also shut down and start up environments to stop and start batch processing of a particular
environment on a machine(s). When you shut down an environment, you are overriding whatever you
already scheduled for it (according to each type of schedule). Therefore, you will stop any batch
processing jobs on the environment until you start that environment again. You can also view a
schedule's status to see an overview of all schedules set for a specified time.

Displaying the Schedule Status
You canmonitor whichmachines are vectorizing or rendering animation data. The schedule status
displays an overview of what each render or vectorizemachine is processing at a specific time. The
overview also displays a machine's status based on the highest priority schedule set for the time you
select.

You can display this status list by typing the Status command in a Command Shell or Terminal on any
machine in the network. When you run the Status command, youmust specify the day and time for
which you want to view the schedule status.

How to display the schedule status list

1. Open a Command Shell or Terminal and type:
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Status

You can view the status for one or moremachines by listing them after the Status command
(instead of all themachines, which is the default). You can also type a prefix to search for machines
with names that start with the same prefix.

Example:

‣ Status hp: Shows the status for all machines that begin with "hp".

‣ Status cm hp6: Shows the status for all machines that begin with "cm" and for hp6.

‣ Status: Shows the status for all machines.

When you press Enter/Return, you are prompted to specify the time for which you want to view the
schedule status.

INPUT BEGIN TIME in 24-hr. format [15:17]:

2. Type the time youwant to view the status for in 24-hour format. If you press Enter/Return without
specifying a time, the system uses the time displayed in brackets (the current time).

When you press Enter/Return, the system prompts you for the day for which you want to view the
status.

input day [wed]:

3. Type the day of the week for which you want to view the status (you can not enter dates). If you
press Enter/Return without entering a day, the system uses the day displayed in brackets (the
current day).

The schedule status for the time and day you specified appears.

Reading the Schedule Status List

When you display the Schedule Status list, the information appears in three separate sections:

• Key: Lists the abbreviations the status schedule uses for the environments, the two types of batch
processes you can schedule on a machine, and the abbreviations the other columns use in the list.

• Schedule Status: Displays the processing status of each vectorizing or rendering machine in the
network.

• Summary: Displays a summary of whichmachines are performing a specific type of batch
processing (vectorize or render). The summary appears directly below the Schedule Status section.

The following table describes the contents of the Schedule Status list:

Column title Description

R

Displays an R for eachmachine that has the tbprocess program
running on it. tbprocess must be running on a machine in order for
that machine to perform batch processing work.

For information on starting tbprocess:

Windows: See Starting the Batch Processing Queue on
Windows on page 117

Linux: See Starting the Batch Processing Queue on Linux on
page 119

If an R does not appear for a machine, the Schedule Status list
displays what would be scheduled if the tbprocess programwas
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running on it.

SD

Indicates if an environment is shut down for batch processing on that
machine. You can specify that certainmachines do not process
environments by selecting themachines that should be shut down
(or turned off).

An asterisk (*) appears in the SD column to indicate that one or more
environments have been shut down for that machine—see Shutting
Down and Starting Up Environments on page 158.

Machine
Displays the name of the networked machine that is configured to
accept batch processing jobs.

State

Indicates whether themachine is available for batch processing.

On: Themachine is scheduled to batch process.

Off: Themachine is not scheduled (for the time you specified) to
batch process.

vec

status

Lists the type of batch processing themachine is scheduled to
perform (vectorize and/or batch processing ).

If an asterisk (*) appears in these columns for a machine, then
this type of batch processing is scheduled for this machine.

If a machine is scheduled to do both types of batch processing,
themachine performs both types alternatively; it processes an
entry from the Vectorize queue, vectorizes the data, and then
take an entry from the Render queue.

Environments

Displays the environments scheduled to be batch processed on a
machine.

Themachine batch processes only the data from the environments
listed in this column.

pri

Displays the priority level for batch processing on a machine. You
can prioritize environments so that onemachine can perform the
batch processing before another.

If an asterisk (*) appears in the pri column, the environments are
prioritized for that machine. The priority order for the environments
appears in the Environments column (reads from left to right,
highest to lowest priority).

nexteventTime

Displays the date and time of the next status change for that
machine, according to the defined batch processing schedules.

For example, even though the hickeymachine is off at themoment,
the Time column indicates that the next time its status will change is
at 12:53 onWednesday, March 8. This indicates that a Periodic or
Supervisory schedule is set for this machine.
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Using Default Schedules
ADefault schedule sets batch processing for a machine when no other schedules are in effect. For
example, if there are no Supervisory or Periodic schedules that affect a particular machine onMonday
at 9:00 a.m., the Default schedule determines the type of batch processing that this machine performs
at that time.

Every Harmony systemmachine uses a Default schedule to determine when it should perform batch
processing. You can display or modify the Default schedules for anymachine in the Harmony system.

This section is divided as follows:

• Displaying Default Schedules below

• Modifying Default Schedules on page 145

Displaying Default Schedules

When you display a Default schedule, you can see all the batch processing machines on the network
and when they are scheduled to perform batch processing work. The Default schedule also displays
the type of batch processing work (vectorize or render) and which environments are scheduled for the
processing work.

After you display the Default schedule, you canmodify it to change the time, type of batch processing,
or environments to process—seeModifying Default Schedules on page 145.

How to display the Default schedule

1. In a Linux shell, type:

Showdef

You are prompted for themachine(s) whose Default schedule you want to see.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to view by typing the name of a singlemachine, a prefix (to select a
range of machines that start with the same prefix), or all to view all the Default schedules for all
themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

You can press Enter/Return to select all themachines in the list or select specific
machines by typing their corresponding numbers.
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You are asked if you want to view moremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to view more environments and machines.

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

The Default schedule for the selected machines appears.

Reading the Default Schedule Status List

When you display the Default schedule status list, the system displays the information in two sections:

• Key: Lists the abbreviations the status schedule uses for the environments, the two types of batch
processes you can schedule on a machine, and the abbreviations the other columns use in the list.

• Schedule Status: Displays the processing status of each vectorizing or rendering machine in the
network

The following table describes the contents of the Schedule Status list:

Column Title Description

Machine
Displays the name of the networked machine that is configured to
accept batch processing jobs.

Status

Indicates whether themachine is available for batch processing.

On: Themachine is scheduled to batch process.

Off: Themachine is not scheduled (for the time you specified) to
batch process.

vec

ren

Lists the type of batch processing themachine is scheduled to
perform (vectorize and/or batch processing ).

If an asterisk (*) appears in these columns for a machine, then
this type of batch processing is scheduled for this machine.

If a machine is scheduled to do both types of batch processing,
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themachine performs both types alternatively; it processes an
entry from the Vectorize queue, vectorizes the data, and then
take an entry from the Render queue.

Environments

Displays the environments scheduled to be batch processed on a
machine.

Themachine batch processes only the data from the environments
listed in this column.

pri

Displays the priority level for batch processing on a machine. You
can prioritize environments so that onemachine can perform the
batch processing before another.

If an asterisk (*) appears in the pri column, the environments are
prioritized for that machine. The priority order for the environments
appears in the Environments column (reads from left to right,
highest to lowest priority).

Time of Last Update

The Default schedule also indicates the last time the schedule was
modified for eachmachine.

This final column displays the date and time that the Default
schedule was last modified for eachmachine.

Modifying Default Schedules

When you are ready to modify the Default schedule, youmust specify the following information:

• Themachine(s) you want to update

• The type of batch processing work you want to assign

• The environments to process

After youmodify the Default schedule, you can use the Showdef command to view your changes—see
Displaying Default Schedules on page 143.

How to modify a Default schedule

1. In a Terminal, Command Prompt or Linux shell, type:

Setdef

2. Press Enter/Return.

You are prompted for themachine(s) whose Default schedule you want to modify.

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

3. Select themachines you want to view by typing the name of a singlemachine, a prefix (to select a
range of machines that start with the same prefix), or all to view all the Default schedules for all
themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.
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If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

You can either press Enter/Return to select all themachines in the list or you can select
certainmachines by typing their corresponding numbers.

You are asked if you want to modify the Default schedule for moremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Decide if you want to modify the Default schedule on other machines.

‣ Type y to select moremachines and press Enter/Return.

You are prompted to select other machines (see step 1 of this procedure).

‣ Type n to not select anymoremachines and press Enter/Return.

You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [yes]

5. Decide if you want themachines to perform vectorizing work on the selected machines.

‣ Type y to schedule vector batch processing and press Enter/Return.

‣ Type n to not schedule vector batch processing and press Enter/Return.

‣ If you press Enter/Return without entering y or n, the prompt uses the answer shown in
brackets.

The system then prompts you to select if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

6. Select if you want themachines to perform rendering work on the selected machines.

• Type y to schedule Render batch processing and press Enter/Return.

• Type n to not schedule Render batch processing and press Enter/Return.

• If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.

You are prompted to select the environments to be scheduled for batch processing.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production
Commercials]

All the environments in your system appear in this list, each one assigned to a number.

7. Type the number that corresponds to the environment(s) you want to schedule and press
Enter/Return. If you press Enter/Return without typing anything, the environments listed in
brackets are used.
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If you select more than one environment, the system asks if you want to establish a priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority
environment first. If you do not define a priority, the batch processing does an equal amount of
work for each environment.

The order in which you type the environment numbers can determine their batch processing
priority in the schedule (the first environment you type has the highest priority). However, the
order in which you type the environments is not important if you do not want to prioritize the
environments (by answering no to the system prompt).

In this example, if you want to schedule only the Production and Tutorials environments for
batch processing, you would type: 1 2, indicating that Production has a higher priority than
Tutorials for batch processing.

8. Decide if you want to assign a priority to the environments you selected. If you press Enter/Return
without entering anything, the system uses the answer shown in brackets.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.

The system prompts you to schedule the status of themachine(s).

input ON or OFF [on]:

9. Decide if you want to apply the Default schedule right away, making themachines available
immediately.

‣ Type on to make themachines available for batch processing according to their defined
Default schedules and press Enter/Return.

‣ Type off to make themachines unavailable for batch processing, regardless of their
defined Default schedules, and press Enter/Return.

‣ If you press Enter/Return without entering on or off, the prompt uses the answer shown in
brackets.

The Default schedule for the specified machines is set. The new schedule appears.

Using Periodic Schedules
The Periodic schedule is an optional schedule that defines a recurring period of timewhen a machine
will perform batch processing. You can create a Periodic schedule by specifying a day of the week
(Monday, Tuesday, etc.) and themachine will perform batch processing on the specified days for every
week.

A Periodic schedule lists batch processing jobs for which youmust define a start and end date, and
time. Each job has its own set of batch processing parameters that are independent of the other jobs
in the schedule.

For example, you can create a Periodic schedule for a machine so that it performs batch processing
every night from 20:00 that evening to 08:00 the following morning. Therefore, themachine would not
perform batch processing work during the day when the users would be present.

In terms of priority, the Periodic schedule is between the Default and Supervisory
schedules. If there are no Supervisory schedules for a machine, or the Supervisory
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However, if you have an active Supervisory schedule , themachine follows this schedule
before it follows either the Periodic or Default schedules.

However, if you have an active Supervisory schedule , themachine follows this schedule
before it follows either the Periodic or Default schedules.

This section is divided as follows:

• Displaying Periodic Schedules below

• Setting a Periodic Schedule on the facing page

• Clearing a Periodic Schedule on page 152

• Using Default Schedules on page 143.

• Using Supervisory Schedules on page 153.

Displaying Periodic Schedules

When you display a Periodic schedule, you can see all the batch processing machines that use this
schedule and when they are scheduled to perform the batch processing. The Periodic schedule also
displays the type of batch processing work (vectorize or render) and the environments that are
scheduled for the processing work.

After you display the Periodic schedule, you canmodify it to change the time, type of batch
processing, or environments to process—see Setting a Periodic Schedule on the facing page.

You can display the Periodic schedule for only one machine at a time.

How to display a Periodic schedule

1. In a Linux shell, type:

Showper

You are prompted for themachine whose Periodic schedule you want to view.

INPUT MACHINE [hickey]:

2. Type the name of themachine for which you want to define a Periodic schedule.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

You can combine these two steps by adding the name of themachine you want to view
at the end of the Showper command.
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For example, if themachine you want to view is called hickey, then youwould type the
following command in a Linux shell to view its Periodic schedule.

Showper hickey

The Periodic schedule for that machine appears.

Setting a Periodic Schedule

When you are ready to modify your Periodic schedule, you need to specify the following information:

• Themachine(s) for which you want to create or update the periodic schedule(s)

• The type of batch processing work you want to assign

• The environments to process

• When to start and stop the batch process

You can add jobs to the schedule if a Periodic schedule already exists for a particular machine, or you
can clear out any pre-existing jobs before setting new jobs in the schedule. You can clear a Periodic
schedule without setting any new jobs—see Clearing a Periodic Schedule on page 152.

How to define a Periodic schedule on a machine

If you press Enter/Return without entering anything, the command uses the information
that appears in brackets of commands.

1. In a Linux shell, type:

Showper

You are prompted for themachine(s) whose Periodic schedule you want to modify.
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INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to modify by typing the name of a singlemachine, a prefix (to select a
range of machines that start with the same prefix), or all to modify all the Periodic schedules for
all themachines.

If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all themachines in the list or select specific machines by
typing their corresponding numbers.

You are asked if you want to modify the Periodic schedule onmoremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

You are prompted to clear the existing schedule before defining new entries.

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Do one of the following:

‣ Type y to remove any existing schedules on themachine(s).

‣ Type n to preserve any existing schedules on themachine(s). The systemwill add your new
entries to the existing set of entries.

You are prompted to schedule any new entries in your Periodic schedule.

WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Do one of the following:

‣ Type y to schedule new entries. Proceed to the next step to define the schedule.

‣ Type n to not schedule any new entries. This cancels the Setper command without
scheduling any new entries.

6. If you typed y to the previous prompt, you are prompted to activate or deactivate the selected
machines.

input ON or OFF [on]:

‣ Type on to activate the Periodic schedule for the selected machines.

‣ Type off to deactivate the Periodic schedule for the selected machines. Themachine(s) will
not perform any Periodic batch processing, regardless of what the other Periodic entries
have been scheduled.
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You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Do one of the following:

‣ Type y to schedule Vector batch processing.

‣ Type n to not schedule Vector batch processing.

The system prompts you to decide if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

8. Do one of the following:

‣ Type y to schedule Render batch processing.

‣ Type n to not schedule Render batch processing.

You are prompted to select the environments to be scheduled for batch processing. All the
environments in your system appear in this list, each one assigned to a number.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production
Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press
[Enter/Return]. If you select more than one environment, the system asks if you want to establish a
priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority
environment first. If you do not define a priority, the batch processing does an equal amount of
work for each environment.

The order in which you type the environment numbers can determine their batch processing
priority in the schedule (the first environment you type has the highest priority). However, the
order in which you type the environments is not important if you don't want to prioritize the
environments (by answering no to the system prompt).

In this example, if you want to schedule only the Production and Tutorials environments for
batch processing, you would type: 1 2, indicating that Production has a higher priority than
Tutorials for batch processing.

10. Select if you want to assign a priority to the environments you selected.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.

The scheduler prompts you to define the time and day when to start the Periodic batch processing.

INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:

11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch
processing and press [Enter/Return].

The scheduler prompts you for the end time.

INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch
processing and press Enter/Return.
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A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that
you want to enter this job in the schedule.

13. Do one of the following:

‣ Type y to add this job into your Periodic schedule.

‣ Type n if you do not want to add this job into your Periodic schedule.

The scheduler gives you the opportunity to add another job to your Periodic schedule.

DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Do one of the following:

‣ Type y to add another job and press Enter/Return. Repeat steps 7 to 13.

‣ Type n if you do not want to enter another job and press Enter/Return.

When you finish adding jobs to the Periodic schedule, a summary of the entire Periodic schedule
appears.

Clearing a Periodic Schedule

If you decide that you do not need to have any recurring batch jobs, you can clear the scheduled jobs
from the Periodic schedule. Once the Periodic schedule is empty, the batch jobs in the Default
schedule come into effect.

You can clear existing jobs from a Periodic schedule without creating any new jobs. However, when
you clear a Periodic schedule, you clear all the jobs that exist for that schedule.

How to clear a Periodic schedule

1. Follow steps 1 to 3See "Setting a Supervisory Schedule" on page 154in Setting a Periodic Schedule
on page 149

2. Type y when you reach the following prompt:

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]

3. Type n when you reach the following prompt:

WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

This clears the Periodic schedule and displays an empty schedule, confirming that the system
cleared the jobs.
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Using Supervisory Schedules
A Supervisory schedule forces a machine to perform batch processing for a non-recurring period of
time. This type of schedule, like the Periodic schedule, is optional. If you have a Supervisory schedule
active for a period of time, themachine performs batch processing according to that schedule before
it references the Periodic or Default schedules.

For example, you could force a machine to perform only Vectorize batch processing for the next four
hours, ignoring any other scheduled type of batch processing during that time.

A Supervisory schedule consists of a list of batch processing jobs for which youmust define a start and
end date and time. Each job has its own set of batch processing parameters that are independent of
the other jobs in the schedule.

The Supervisory schedule holds the highest priority level, superseding the Periodic schedule and Default
schedule. Therefore, if you have an active Supervisory schedule, the machine follows this schedule before it
follows the Periodic or Default schedules.

This section is divided as follows:

• Displaying Supervisory Schedules below

• Setting a Supervisory Schedule on the next page

• Clearing a Supervisory Schedule on page 157

• Using Default Schedules on page 143.

• Using Periodic Schedules on page 147.

Displaying Supervisory Schedules

When you display a Supervisory schedule, you can see all the batch processing machines that use this
schedule and when they are scheduled to perform the batch processing. The Supervisory schedule also
displays the type of batch processing work (vectorize or render) and the environments that are
scheduled for the processing work.

After you display the Supervisory schedule, you canmodify it to change the time, type of batch
processing, or environments to process—see Setting a Supervisory Schedule on the next page.

You can display the Supervisory schedule for only one machine at a time.

How to display a Supervisory schedule

1. In a Linux shell, type:

Showsup

You are prompted for themachine whose Supervisory schedule you want to view.
INPUT MACHINE [hickey]:
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2. Type the name of themachine for which you want to define a Supervisory schedule.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

You can combine these two steps by adding the name of themachine you want to view
at the end of the Showsup command.

For example, if themachine you want to view is called hickey, then youwould type the
following command in a Linux shell to view its Supervisory schedule.

Showsup hickey

The Supervisory schedule for themachine appears.

Setting a Supervisory Schedule

When you are ready to modify your Supervisory Schedule, you need to specify the following:

• Themachine(s) for which you want to create or update the supervisory schedule(s)

• The type of batch processing work you want to assign

• The environments to process

• When to start and stop the batch process

You can add jobs to the schedule if a Supervisory Schedule already exists for a particular machine, or
you can clear out any pre-existing jobs before setting new jobs in the schedule. You can clear a
Supervisory Schedule without setting any new jobs (see Clearing a Supervisory Schedule on page 157).

How to define a Supervisory schedule on a machine

If you press Enter/Return without entering anything, the command uses the information
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that appears in brackets of commands.

1. In a Linux shell, type:

Showsup

You are prompted for themachine(s) whose Supervisory schedule you want to modify.

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to modify by typing the name of a singlemachine, a prefix (to select a
range of machines that start with the same prefix), or all to modify all the Supervisory schedules
for all themachines.

If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all themachines in the list or select specific machines by
typing their corresponding numbers.

You are asked if you want to modify the Supervisory schedule onmoremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

You are prompted to clear the existing schedule before defining new entries.

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Do one of the following:

‣ Type y to remove any existing schedules on themachine(s).

‣ Type n to preserve any existing schedules on themachine(s). The systemwill add your new
entries to the existing set of entries.

You are prompted to schedule any new entries in your Supervisory schedule.

WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Do one of the following:

‣ Type y to schedule new entries. Proceed to the next step to define the schedule.
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‣ Type n to not schedule any new entries. This cancels the Setper command without
scheduling any new entries.

6. If you typed y to the previous prompt, you are prompted to activate or deactivate the selected
machines.

input ON or OFF [on]:

‣ Type on to activate the Supervisory schedule for the selected machines.

‣ Type off to deactivate the Supervisory schedule for the selected machines. Themachine(s)
will not perform any Supervisory batch processing, regardless of what the other Supervisory
entries have been scheduled.

You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Do one of the following:

‣ Type y to schedule Vector batch processing.

‣ Type n to not schedule Vector batch processing.

The system prompts you to decide if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

8. Do one of the following:

‣ Type y to schedule Render batch processing.

‣ Type n to not schedule Render batch processing.

You are prompted to select the environments to be scheduled for batch processing. All the
environments in your system appear in this list, each one assigned to a number.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production
Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press
[Enter/Return]. If you select more than one environment, the system asks if you want to establish a
priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority
environment first. If you do not define a priority, the batch processing does an equal amount of
work for each environment.

The order in which you type the environment numbers can determine their batch processing
priority in the schedule (the first environment you type has the highest priority). However, the
order in which you type the environments is not important if you don't want to prioritize the
environments (by answering no to the system prompt).

In this example, if you want to schedule only the Production and Tutorials environments for
batch processing, you would type: 1 2, indicating that Production has a higher priority than
Tutorials for batch processing.

10. Select if you want to assign a priority to the environments you selected.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.
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The scheduler prompts you to define the time and day when to start the Supervisory batch
processing.

INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:

11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch
processing and press Enter/Return.

The scheduler prompts you for the end time.

INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch
processing and press Enter/Return.

A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that
you want to enter this job in the schedule.

13. Do one of the following:

‣ Type y to add this job into your Supervisory schedule.

‣ Type n if you do not want to add this job into your Supervisory schedule.

The scheduler gives you the opportunity to add another job to your Supervisory schedule.

DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Do one of the following:

‣ Type y to add another job and press Enter/Return. Repeat steps 7 to 13.

‣ Type n if you do not want to enter another job and press Enter/Return.

When you finish adding jobs to the Supervisory schedule, a summary of the entire Supervisory
schedule appears.

Clearing a Supervisory Schedule

If you decide you don't need to set a Supervisory schedule for your batch processing jobs, you can
clear the scheduled jobs from the Supervisory schedule. Once the Supervisory schedule is empty, the
batch processing jobs in the Periodic and Default schedules come into effect.

You can clear existing jobs from a Supervisory schedule without creating any new jobs. However, when
you clear a Supervisory schedule, you clear all of the jobs that exist for that schedule.

How to clear a Supervisory schedule

1. Follow steps 1 to 3See "Setting a Supervisory Schedule" on page 154in Setting a Supervisory
Schedule on page 154.

2. Type y when you reach the following prompt:

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]

The Supervisory schedule is cleared. An empty schedule displayed, confirming that the system
cleared the jobs.
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Shutting Down and Starting Up Environments
In some cases, youmust shut down a machine so it does not process any batch jobs from an
environment or for a specific amount of time. Youmay want to, for example, shut down batch
processing for all environments on a singlemachine so you can reboot themachine. Or you can shut
down one environment on all machines so you canmove scenes in that environment to other machines.

To determine if an environment is shut down on a particular machine, type Status in a Command
Shell or Terminal. If you see an asterisk (*) in the SD column for a particular machine, this means at least
one environment is shut down on that machine.

You can view the Supervisory and Periodic schedules for the shut downmachines to isolate which
environments are shut down.

This section is divided as follows:

• Using Supervisory Schedules on page 153.

• Using Supervisory Schedules on page 153.

Shutting Down Environments

When you shut down an environment, this overrides whatever was scheduled for that environment (for
all three types of schedules). The environment remains shut down until you reinstate it by typing
Suenv command in a Command Shell or Terminal (see Starting Up Environments on the facing page).
You can shut downmultiple environments onmultiplemachines, from anymachine in the network.

When shutting down an environment, the command prompts you for the environments you want to
close and themachines on which you want them to be shut down.

How to shut down an environment on a machine

1. In a Command Shell or Terminal, type:

Sdenv

You are prompted for the environments to shut down:

INPUT DATABASES TO BE STOPPED

INPUT A SET OF DATABASE Environments

1 = Production, 2 = Tutorials, 3 = Commercials, default =
[Production Tutorials Commercials]

All the Environments appear in this list and each one has its own number.
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2. Type the number that corresponds to each environment you want to shut down (separate each
number by a space) and press Enter/Return.

You are prompted you for themachine(s) on which you want the environments to be shut down:

INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE SHUTDOWN

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:

3. Select themachines that should not process the shut down environment by typing the name of a
singlemachine, a prefix (to select a range of machines that start with the same prefix), or all to
shut down all the environments on all themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all themachines in the list or select specific machines by
typing their corresponding numbers.

You are prompted to decide if you want to shut downmoremachines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

You are asked if you want to shut downmore environments and machines.

4. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

A summary of the shutdown appears:

here are the 3 machines you input: hickey weiner garneau

ALL MACHINES HAVE REPORTED. SHUT DOWN COMPLETE.

The Sdenv command waits for a response from all the selected machines. The Sdenv command
does not terminate a batch process that is currently running on a machine. If a machine is currently
performing a batch process, it will not shut down until it completes the queue entry.

Starting Up Environments

When you are ready to re-start the batch process on an Environment that was shut down, you can use
the Suenv command. When you restart an Environment, the command prompts you for the
Environments you want to start up and themachines you want them to start running on.
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If you accidentally restart an environment that is already active, nothing happens.

How to start up an environment

1. In a Command Shell or Terminal, type:

Suenv

You are prompted for the environments to restart:

INPUT DATABASES TO BE STARTEDINPUT A SET OF DATABASE Environments

1 = Production, 2 = Tutorials, 3 = Commercials, default = []

All the environments in your system appear in this list and each one has a number.

2. Type the numbers that correspond to each environment you want to restart (separate each
number by a space) and press Enter/Return.

You are prompted for themachine(s) you want to process the environments:

INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE STARTED

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:

3. Select themachines for processing the environment by typing the name of a singlemachine, a
prefix (to select a range of machines that start with the same prefix), or all to restart all the
environments on all themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the
numbers that correspond to themachines you want to view.

For example, if you have threemachines that start with "hi", you can type hi as a prefix.
The systemwould then display a list of all themachines that start with"hi":

input a set of machines, or hit return to indicate all these
machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all themachines in the list or select specific machines by
typing their corresponding numbers.

You are prompted to decide if you want to restart enviroments onmoremachines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Do one of the following:

‣ Type y to select moremachines.
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‣ Type n to not select anymoremachines.

A summary of the started machines appears:

here are the 3 machines you input: hickey weiner garneau

ALL MACHINES HAVE REPORTED. STARTUP COMPLETE.

A Summary of Scheduling Commands
The following table lists the batch processing scheduling commands and parameters that are useful
for managing the batch processing schedule.

Command Effect

Status Displays the Schedule Status (default for all
machines).

Options:

[machine]: Limits the display to
specified machines (separatemachine
names with spaces).

[prefix]: Limits the display to machines
with specified prefix.

Showdef Displays Default schedules.

Setdef Modifies Default schedules.

Showper Displays Periodic schedule (for a singlemachine
only).

Options:

[machine]: Specifies themachine whose
Periodic schedule you want to display.

Setper Sets and/or clears Periodic schedule.

Showsup Displays Supervisory schedule (for a single
machine only).

Options:

[machine]: Specifies themachine whose
Supervisory schedule you want to display.

Setsup Sets and/or clears Supervisory schedules.

Sdenv Shuts down environments.

Suenv Starts up environments.

start_process_starter Starts process running on a machine (youmust
be logged into themachine, and should be
SuperUser when running this command).
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Command Effect

tail -options file Displays last 10 lines of specified file (Linux).

Options:

-n: Specifies the number of lines from the
file to display.

-f: Updates the display as the file changes
(must use Ctrl + C or Breal key to quit).

ps Options:

-f: Displays full listing.

-u [username]: Limits display to specified
Linux user name.
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Index

Adminmenu
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assistant technical director 32,
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commands, schedules 161

configuring machine-list
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Default schedule 139, 143
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Periodic schedule 139, 147

clearing 152
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Render queue, viewing 130
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schedules 139
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environments 158
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environments 158

status of schedules 140
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clearing 157
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Cloud module 61
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interface 63
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managing users 66

modifying user
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import/export
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user password, updating 71

user types and
restrictions 72
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Control Center 11
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assistant technical
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ATD 32, 81

batch processing schedule,
setting up 124

batch processing, stopping
onWindows 133

changing stage status 40, 89

clearing scenes 41, 89

commands 53

creating scenes 35, 83

default user, creating 24

deleting environment 28, 77

deleting scenes 36

deleting users 20

environment 25, 74

environments, creating 27,
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export data 46

exporting data 45

exporting files to storage
device, Linux 49

import or export not
successful 45

importing data 45

importing files 50

interface 15

jobs 25, 74

jobs, changing priority 33,
82

jobs, changing stage 33, 82

jobs, creating 31

jobs, deleting 34, 82

managing environments, job,
scenes 25

managing Harmony users 18

managing scenes 34, 83
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modifying user
information 21

moving scenes 39, 88

renaming scenes 39, 88

resequencing scenes 41, 89

resolution file, setting 28

restrictions 22

scenes 25, 74

sending scenes to
Render 43, 90

sending scenes to
unvectorize 91

sending scenes to
Vectorization 91

starting 12

stopping batch process 133

tbprocess program 117
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testing batch processing 126

updating scenes 37, 40, 86,
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exporting files to storage
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managing in Control
Center 25-26, 75

managing, cloud 74

shutting down 158
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Linux 49

troubleshooting 107
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Control Center 53
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global lock 17
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Harmony server 9

Help menu

Control Center 59

importing

data 45, 103

files, Control Center 50

import not successful 45

troubleshooting 107

Info-ZIP license 7

jobs 25, 74
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changing stage of job 33, 82

creating 31

creating, cloud 80

deleting 34, 82

managing, cloud 30, 74, 78

managing, Control
Center 25

priority 33
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jobs 33, 82

Jobs menu

Control Center 54
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See starting. 12
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Info-ZIP 7

machine-list file 114
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managing
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deleting users, cloud 69

environments 25-26, 75
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updating user password,
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menus

Admin, Control Center 58

Control Center 53
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File, Control Center 53
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Scene, Control Center 55

modules
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Render queue 93
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viewing 130

rendering 109

scenes 130
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scenes 41, 89

resolution

resolution.conf file 28

resolution.conf file 28
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Control Center 22

user, cloud 72

Scenemenu

Control Center 55

scenes
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Center 84

changing stage status 40, 89

clearing in Control
Center 41, 89

Control Center 25, 74

creating in Control
Center 35, 83

deleting in Control
Center 36

managing in Control
Center 25, 34, 83
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moving in Control Center 39,
88
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renaming in Control
Center 39, 88

rendering scenes 130
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sending scenes to
unvectorize 91
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queue 43, 90

sending to Vectorization
queue 91

unvectorize 91

updating in Control
Center 37, 86

updating priority in Control
Center 40, 88

vectorizing batches 127

viewing preview clip 98

schedules, batch
processing 139

commands 161

Default schedule 139, 143

Default schedule,
displaying 143-144

Periodic schedule 139, 147

Periodic schedule,
clearing 152

Periodic schedule,
displaying 148

Periodic schedule,
setting 149

schedule status list 141

status 140

Supervisory schedule 139

Supervisory schedule,
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Supervisory schedule,
setting 154

server

Harmony 9

Stage

opening scenes 85
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stage status

changing in Control
Center 40, 89

starting

Control Center 12

status

schedules, batch
processing 140

Supervisory schedule 139

clearing 157

displaying 153

setting 154

using 153

tbprocess program 117

testing

batch processing 126

troubleshooting

import or export not
successful 45

unvectorizing

scenes 91

usabatch 18
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viewing in Control Center 19
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configuring in Harmony
Cloud 66
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Cloud module 72

users, Control Center

adding 19

deleting 20
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adding 67

deleting 69

modifying user
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Vectorization queue 93

opening 95
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viewing
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